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1) BESA

1. Notes

This user manual is a guide to the research product BESA Statistics — a stand-alone software
program.

The manual introduces the features, workflows, and the Main Windows and dialogs of the BESA
Statistics software. A help function is provided within the software. Press F1 on the keyboard or select
menu item Help - BESA Statistics Help for help.

Before starting to work with BESA Statistics, please read this user manual carefully.
Please report any suggestions and errors found in this manual via email to

BESA GmbH provides support to all customers who have purchased BESA Statistics directly from our
sales office ( ) or through our distributors.

BESA GmbH
Freihamer Str. 18
82166 Gréfelfing - Germany

Support: http://besa.de/contact/support/form.php

2. Indications for Use

BESA Statistics is a software-only product compatible with personal computers running under a
Windows operating system or an emulator thereof. The software is intended (a) to find reliable
differences between EEG / MEG data of two or more groups / conditions, and (b) to look for reliable
correlations between EEG / MEG data and an external factor using a cluster-permutation approach.

It is possible to compute cross-subject statistics of event-related potentials / fields (ERP / ERF), source
waveforms, images, time-frequency data, coherence values and (inter-trial) phase-locking values.

The statistical method is permutation testing on the basis of t-tests, F-tests, or correlations. If
applicable, permutation tests run on temporal, frequency and / or spatial clusters, thus enabling the
best-possible control of multiple comparisons without restricting statistical power unnecessarily.

BESA Statistics integrates optimally with data that were analyzed in BESA Research, but it can also
process data from other software packages as long as they conform to the BESA Statistics file format.

The intended user is a neuroscience professional with a basic understanding of statistical methods
applied to experiments in neurophysiology.

It is not allowed to use the BESA Statistics software directly or indirectly for medical diagnosis and/or
treatment of humans. BESA GmbH is not liable for the use of the software beyond the intended
research purpose.

BESA Statistics software is licensed for research use only.


mailto:feedback@besa.de
mailto:sales@besa.de
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3. Product Classification and Certification

3.1. Classification

According to MDD 93/42/EEC, Annex IX, rule 10, BESA Statistics is a Class | software product for the
statistical analysis of EEG / MEG data across subjects.

According to safety classifications in DIN/EN IEC 62304:2006, BESA Statistics is a Class A product
(class A: no injury or damage to health is possible).

The product is noninvasive since it is stand-alone software and does not control any equipment
physically connected to a patient. It is designed purely for data analysis. No physical devices are
controlled or driven by BESA Statistics, nor is any active feedback provided to the patient. Any direct
physical damage to the patient, for example, during the recording of data, can therefore be excluded.
According to DIN EN IEC 60601-1:2005, BESA Statistics does not affect the possibility of using the
computer within a patient environment. BESA Statistics does not interfere with other programs or
hardware connected to the computer (third-party equipment)

BESA Statistics is classified with the following codes:

GMDN collective term: CT112 (Software, application program)

3.2. Certification

C€

The CE marking certifies that this product fulfills the basic requirements of the Medical Devices
Directive MDD 93/42/EEC.

4. System Requirements

e Operating system: Windows® 8.1 (Touch not supported)

Windows® 7 — 32bit and 64bit systems

o CPU: Minimum 2 GHz

¢ RAM: Minimum 2 GB

o Display resolution: Minimum 1280x800 pixels

¢ Graphics card: OpenGL 1.1 with 16 MB RAM or more

5. Disposal Information

The BESA dongle and the BESA Statistics CD must be disposed of according to the national
guidelines on environmental protection.
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6. Installation and Initial Setup

The installation and initial setup of BESA Statistics must be carried out by an administrator or an
experienced technician.

6.1. Before Setup

BESA Statistics is available as a 32 bit or a 64 bit program. The latter version prevents memory
problems caused by a 32 bit restriction. Therefore, we recommend using the 64 bit version if
your Windows system supports it. Please make sure to check this before the installation. The
installation and initial setup of BESA Statistics must be carried out by an administrator or
experienced technical staff.

6.2. Installation
1. Start Windows and insert the installation disk into the CD-ROM drive.
2. If the PC permits auto start from the CD drive, the installation starts automatically after a short
time. If the PC does not permit auto start, please run Setup.exe from the CD. The file is located
in the Setup folder.

3. Please follow the on-screen instructions.

4. Once the installation is complete, proceed with the initial setup as explained in the following
chapter.

6.3. Initial setup

The following section explains the steps for the initial setup of BESA Statistics. These steps have to be
performed only once per installation.

6.3.1. Connect the BESA Dongle

BESA Statistics is protected by a licensing scheme developed by SafeNet Inc. During the installation
the device drivers for the BESA dongles will be installed automatically.

Connect the BESA dongle to your personal computer or a server machine and proceed with the next
step. If required, check for correct installation as described below.

If the dongle is installed correctly, the Windows Device a. W Universal Serial Bus controllers
Manager reports three items in the “Universal Serial Bus - ¥ SafeNet Inc. HASP Key
controllers section: SafeNet Inc. HASP Key, SafeNet Inc. ...... § SafeNet Inc. Sentinel HASP Key

Sentinel HASP Key and SafeNet Inc. USB Key L § SafeNet Inc. USB Key

The SafeNet Inc. HASP key installer includes the HASP License Manager
application:

When this application is running, you should be able to load the Sentinel Admin Control Center by
typing in your internet browser. The connected dongle should be displayed
there. If you do not see the dongle, please wait a few seconds.


http://localhost:1947/

®
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E=8 0
o‘ | B ntip/1ocalnost 1947/ int Jdeviceshim 0 ~ ¢ || B safeNet Sentinel ACC: Senti ok
~
@afeNet
Sentinel Keys Available on LAT6430-MICHAEL
# Location Vendor KeylID Key Type Configuration Version  Sessions Actions
Products 1 Local 87128 1968804532  Sentinel HL NetTime 10 ‘D HASP 4.27 - | Products || Features || Sessions | Blinkon | C2V

Features
Sessions

Update/Attach
Access Log
Configuration

Diagnostics

Help
About

If the dongle is not installed correctly, one of the following message boxes is displayed when the
program is started.

HASP SRM Protection System (3w HASP SRM Protection System =

'Q/,. HASP key not found (HO007) 'Q. Unable to access HASP SEM Run-time Environment (H0033)

The message box on the left appears for one of the following reasons:
e The BESA dongle is not connected.

Solution: Ensure that the key is accessible in order to run the program.
e USB port is defective.

Solution: Check if the LED is lit on the HASP Protection Key. If not, remove and re-insert. Wait
for the operating system to detect the device. If it still does not light up, try another USB port.

e Faulty dongle.

Solution: On rare occasions, the HASP Protection Keys may be faulty. The dongle does not light
up in this case and is not detected in the Device Manager. Request a replacement dongle.

The above right message box comes up for one of the following reasons:
. is blocked by a firewall or an anti-virus application.

Solution: Add in the exception list of the anti-virus and
firewall applications.

o Port 1947 is blocked by a firewall application.
Solution: Add port 1947 to the exception list of the firewall application.

o HASP License Manager Service is stopped.
8
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Solution: Restart the Sentinel HASP License Manager Service (Control Panel\System and
Security\Administrative Tools - Services)

Installation and Initial Setup

6.3.2. Start the Program

Start BESA Statistics using the shortcut created on the desktop or run BESA

A Statistics.exe from the All Programs > BESA -> Statistics 2.0 folder in
Startup menu.

R

BesaStatistics.exe First, the Welcome Screen appears. Press Accept to start BESA Statistics.

6.3.3. Specify the BESA Statistics Data Folder

As initial configuration step, the BESA Statistics Data Folder must be specified. This is the folder
where BESA Statistics stores all project and result data to and reads from.

When starting the program for the first time, the following dialog box appears:

() Select the BESA Statistics Data Folde: S

Please select the BESA Statistics Data Folder.
All project data will be saved to this folder.

MNote: If needed, you may switch between different BESA Statistics Data folders using the menu item
‘File — Select Data Folder.

C:\Users\Public\Documents\BESA Statistics\Projects\

The BESA Statistics Data Folder is preselected to All Users on the local PC (shown above for
Windows 7).

Press the OK button if you want to use the preselected local folder in All Users.
Press the Edit button to create your BESA Statistics Data Folder elsewhere, e.g. on a server.

When the selection is accepted, the following confirmation dialog appears:

() BESA Statistics [m)

The BESA Statistics Data Folder has been selected successfully.
Project data will be written to and read from folder
C\Users\Publict

Update Data Folder Info

Press the OK button.

BESA Statistics is now configured to start projects.
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6.3.3.1. Notes

1.

10

The procedure to define the shared BESA Statistics Data folder on the server needs to be carried
out only once at each PC where you install BESA Statistics, i.e. when starting the program for the
first time.

When switching between BESA Statistics Data folders, it is recommended to leave the tick mark
on to update all existing projects in the new BESA Statistics Data folder.
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7. Introduction

7.1. Features of BESA Statistics

BESA Statistics provides optimized, user-guided workflows for cross-subject analysis of EEG / MEG
data. The statistical method used is parameter-free permutation testing on the basis of t-tests, F-tests
(ANOVA / ANCOVA), or correlations. The program is maximally user-friendly. All analyses are
computed automatically with required user-interaction reduced to a minimum. Statistical values
computed in BESA Statistics can be directly used for scientific reports. No further analysis in other
programs is needed. All results are visualized and can be directly used for publications.

BESA Statistics integrates optimally with data that were analyzed in BESA Research, but it can also

process data from other software packages as long as they conform to the BESA Statistics file format.
The native format of the BrainVision Analyzer 2 software is also supported.

BESA Statistics will automatically identify clusters in time, and if applicable frequency and space
where data of the input groups / conditions are not interchangeable, i.e. where the null-hypothesis that
all groups / conditions are equal must be rejected. Results are considered corrected for multiple
comparisons as only those clusters will be identified that have higher cluster values than 95% of all
clusters derived by random permutation of data (8.2). Thus, results obtained by BESA Statistics are
objective and robust.
There are four (for ANOVA / ANCOVA five) worksteps in BESA Statistics:
1. Selecting the statistical test and starting a project (see 12.3)
o t-test
e ANOVA/ANCOVA (F-test)
e Correlation
2. Loading data and selection of data type (see 12.4)
e ERP /ERF data
e Source waveforms
o Time-frequency data
e Coherence values
e (Inter-trial) phase-locking values
¢ Image data
3. Preliminary parametric statistics (see 12.8)
An initial parametric test according to the choice made in the first workstep will be computed to
retrieve a preliminary statistical comparison between groups / conditions, or a correlation
between a covariate of interest and EEG / MEG data. The preliminary results are used for
cluster-building and subsequent permutation testing. At this step, it is possible to define time-

windows and / or frequency windows of interest that will be passed on to permutation testing.
The methods used for preliminary parametric testing is described in chapter 8.1.

11
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4. Non-parametric Permutation testing (12.9)

A permutation test will run on the time and / or frequency period as defined in 3). The
generated results will show clusters in time, frequency and / or space where the null-
hypothesis that assumes equality or exchangeability of all groups / conditions is rejected, i.e.
where groups / conditions are not exchangeable and thus significantly different from each
other. The non-parametric permutation test is described in more detail in chapter 8.2.

5. Non-parametric Post-Hoc testing (for ANOVA / ANCOVA only, 12.10)
If an ANOVA / ANCOVA was used as the input for permutation testing, a post-hoc Scheffe’s

test will be computed to determine, which pairwise comparison(s) were responsible for the
group / condition main effect. Post-hoc testing is described in detail in chapter 8.3.

12
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8. Statistical Methods

8.1. Preliminary Tests and Subsequent Permutation

BESA Statistics offers three statistical tests for analyzing EEG / MEG data. A t-test is applicable if the
exchangeability of two groups / conditions is to be tested (8.1.1). If the exchangeability of more than
two groups / conditions is to be tested, a one-way ANOVA (F-test) can be chosen (8.1.2). If the
relationship between a continuous factor (e.g. cortisol level) and EEG / MEG data is of interest, BESA
Statistics offers a correlation workflow (8.1.3). These tests are considered preliminary in BESA
Statistics, as they are calculated sample-wise and are subject to a multiple comparisons error, i.e. they
can wrongly suggest significance. Therefore, BESA statistics runs a permutation test on data clusters
derived from the preliminary test statistic. The resulting parameter-free permutation statistics are
robust and not subject to the multiple comparisons problem. The following chapters describe the
preliminary statistical tests as well as the permutation test in more detail.

8.1.1. Preliminary t-test - parametric

Student’s t-test (Hays 1988) is computed to determine whether there is a significant difference
between the mean of two groups / conditions. A t-test is associated with a t-value and a corresponding
p-value which indicates the significance of an effect. P-values smaller than 0.05 are generally
considered significant. The p-value becomes smaller if the t-value becomes larger. t-values are
influenced by the size of the difference between the group / condition means and the size of the
variance in both groups / conditions. Generally speaking, the difference between two group / condition
means can be small for the test to become significant if the variance in both groups is also small. On
the other hand, a large difference between two group / condition means does not automatically imply a
significant effect. It is also required that the variance in both groups / conditions is not too large. Apart
from the t-value, the p-value is influenced by the degrees of freedom (DF) for the specific test
computed. DF are dependent on the number of subjects. The more subjects constitute the groups /
conditions, the larger the DF. Larger DF are more likely to be associated with a significant test result,
as variance can be estimated more precisely with a larger number of subjects.

A t-test can be paired or unpaired. A paired t-test is appropriate when there is an interdependency
between the two conditions that are compared. This is generally the case if two conditions in the same
set of subjects are compared (e.g. subjects listening to high intensity vs. low intensity tones) or if the
same subject is measured twice for the same task (e.g. listening to 1000 Hz tones before and after a
training period). An unpaired t-test is appropriate when there is no interdependency between the two
groups that are being compared. This is generally the case if two different groups of subjects are
compared for the same condition (e.g. motor response in left-handed subjects vs. right-handed
subjects). The selection of the correct type of t-test is important: in a paired t-test smaller differences
between conditions are necessary for the test to become significant in comparison to an unpaired t-
test.

Generally speaking, the likelihood of obtaining significant results is higher if a specific hypothesis
about the data is tested. When there is no specific hypothesis as to whether one group / condition has
higher or lower values than the other group /condition, a two-tailed t-test should be selected. When
there is the hypothesis that the first group / condition has higher values than the second group /
condition, a one-tailed-right t-test should be calculated. When there is the hypothesis that the second
group /condition has higher values than the first group / condition, a one-tailed-left t-test should be
calculated.

8.1.2. Preliminary One-Way Analysis of (Co)Variance (ANOVA / ANCOVA)
— parametric (F-test)

8.1.2.1. ANOVA

A one-way analysis of variance ANOVA investigates the influence of an independent variable with two
or more factor levels on a dependent variable. The null-hypothesis assumes that the means of all
groups / conditions are equal. It gets rejected as soon as there are at least two groups / conditions
with significantly different means, i.e. it is not required that all groups / conditions must differ from each

13
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other. An ANOVA is associated with an F-value and a corresponding p-value indicating the
significance of an effect. As outlined in the previous chapter (8.1.1.) p-values smaller than 0.05 are
generally considered significant. The p-value becomes smaller if the F-value becomes larger. F-values
are influenced by the size of the difference between the group / condition means and the size of the
variance in the groups / conditions and the degrees of freedom. For more details on ANOVAs, see
(Bortz 2005).

ANOVAs can be computed between-group or within-group (repeated measures). Between-group
means that there is no interdependency between the factor levels of the independent variable. This is
usually the case if different groups are compared, i.e. groups of subjects from different populations.
For example, it might be a research question whether the P300 amplitude is significantly different
between control subjects, depressed patients and anxiety patients. As different subjects populate the
groups, they are considered independent. Within-group (repeated measures) means that there is a
relationship between the factor levels of the independent variable. This is usually the case if different
conditions within the same set of subjects are compared. For example, the N100 amplitude might
differ when the same set of subjects listen to 100dB, 80dB, and 60dB versions of the same sound. An
alternative scenario for a within-group (repeated measures) ANOVA is that the dependent variable is
investigated in the same set of subjects more than once, e.g. one week before a treatment,
immediately after a treatment and at one month follow-up. Therefore, BESA Statistics considers the
independent variable to be “Group” for between-group analyses and “Condition” for within-group
analyses.

8.1.2.2. Preliminary One-Way Analysis of Covariance (ANCOVA) - parametric

It is possible to add a covariate of no interest in the one-way ANOVA computation altering it to a one-
way analysis of covariance (ANCOVA). “Covariate of no interest” denotes a factor that might influence
the dependent variable in its own right, thus interacting with the independent variable of interest in an
unwanted fashion. By computing an ANCOVA, the dependent variable is corrected for the influence of
the covariate of no interest. It is required that the covariate of no interest correlates with the dependent
variable, that the direction of the correlation is the same in all factor levels of the independent variable
and also that the factor levels of the independent variable should not differ significantly in the covariate
of no interest (see important note below).

A covariate of no interest must have numerical values (e.g. 5.9, 4.2, etc.), it cannot be categorical (e.g.
male, female). One value must be present per subject. Here is an example for a between-group
ANCOVA: A research question might be, whether the ERN component is different in control subjects,
depressed patients and patients with anxiety disorder. It is suspected that the cortisol blood level can
also influence the ERN. As the main question refers to group differences and not the influence of
cortisol on the ERN, “cortisol level” is considered a covariate of no interest. Thus, it is entered in the
ANCOVA for each group to correct the ERN data for the influence of cortisol level. If there is no
dependency between the influence of blood cortisol level and the influence of the independent variable
(e.g. group status) on ERN amplitude, a potential group main effect for ERN amplitude will become
more significant after controlling for the covariate of no interest.

It is also possible to run a within-group (repeated measures) ANCOVA: For example, it might be of
interest, if the ERN is influenced by an error monitoring training. Thus, anxiety patients were tested 1
week before the training, immediately after the training and at one month follow-up. “Cortisol level” is
the covariate of no interest as it might change from measurement to measurement and have an
unwanted influence on the ERN. Thus, cortisol levels for each measurement are entered in the
ANCOVA.

14
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Important note:

If groups / conditions differ significantly in the covariate of no interest (this can be checked by an
independent ANOVA), results of the ANCOVA must be interpreted with caution as there is a
systematic relationship between the independent variable and the covariate of no interest. Let us
revisit the between-group ANOVA example from above and assume that there was a significant
difference in ERN amplitude between control subjects and patients with depression and patients with
anxiety. At the same time, the three groups differ significantly in their blood cortisol level. When
entering cortisol level in the ANCOVA to control for the influence of blood cortisol levels, the ERN
group-effect becomes non-significant. The conclusion that after “controlling for” blood cortisol level the
groups do not differ in ERN amplitude is wrong. It is very likely that blood cortisol level is a descriptor
of the three patient groups, e.g. a low blood cortisol level is likely to predict that a person is a control
subject, whereas a high cortisol level likely predicts that a subject is a patient with depression. Taking
out the effect of cortisol blood level in the ANCOVA —in this scenario — means that an important factor
that predicts the affiliation with the three group factors (independent variables) gets eliminated. The
correct interpretation would be that the groups do differ in ERN amplitude, but that this effect is likely
to be related to differing blood cortisol levels, which are inherently related to group status. If however
the group difference in ERN amplitude remains intact even after using blood cortisol level as covariate
of no interest, it is a very strong argument that it is indeed the independent variable (i.e. group
membership) that is associated with different ERN amplitudes. ERN amplitude does not seem to be
influenced by cortisol levels, despite the groups differing significantly in this factor. For a very good
discussion on ANCOVA analyses and their interpretations see (Miller and Chapman 2001).

8.1.2.3. Post-Hoc Testing

When a main effect in a one-way ANOVA / ANCOVA with more than two groups / conditions becomes
significant, it is not clear, which groups / conditions differ from each other. As described in chapter
8.1.2,, it is sufficient that at least two groups / conditions differ from each other for the F-test to
become significant. In order to find out, which / groups conditions are responsible for the main effect,
post hoc testing needs to be performed. In principle, post-hoc testing could be done with t-tests for all
available group / condition pairings. This is not recommended, however, as a t-test would over-
estimate the statistical significance of mean differences as it does not take into account that more than
two sample sets were drawn from the population in the original F-test. This can lead to data clusters
outside the cluster boundaries originally identified with the F-test. In order to prevent this from
happening, BESA Statistics uses Scheffe’s test (Winer, Brown et al. 1991) for post-hoc testing. It
specifically takes into account that more than two sample sets were drawn from the population and
guarantees that no clusters can appear outside the boundaries set by the F-test. The application of
Scheffe’s test in the permutation setting is described in chapter 8.3.

8.1.3. Preliminary Correlation

In contrast to the ANCOVA, where the influence of a covariate on the dependent variable is unwanted
and of no interest, the opposite is the case for correlation. Correlation analysis investigates the
relationship between two variables. It is dependent on the covariance of the two variables, i.e. the
estimate of how much the two variables are changing together, the standard deviation of the two
variables and the degrees of freedom. Correlation analysis yields an r-value that can be positive or
negative, and associated t-values and p-values. An r-value of 1 means that there is a perfect positive
relationship between the two variables. The direction of the relationship is the same, i.e. if values in
one variables increase, values in the other variable also increase. An r-value of -1 means that there is
a perfect negative relationship between the two variables. If the values in one variable increase, the
values in the other variable decrease. An r-value of 0 means that there is no relationship at all.
Besides the r-value it is also possible to depict the relationship of the two variables with a regression
line. For more details on correlation analysis see (Pearson 1896).

A covariate of no interest must have numerical values (e.g. 5.9, 4.2, etc.), it cannot be categorical (e.g.
male, female). One value must be present per subject. As an example, it might be of interest, if there
is a relationship between a subject’s cortisol blood level and the ERN component in the EEG. A
positive correlation would indicate that higher cortisol levels are associated with higher ERNs. A
negative correlation would indicate that higher cortisol levels are associated with lower ERNs and vice
versa.
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8.2. Permutation Test (non-parametric)

When computing a large number of tests, the probability of obtaining a significant result by chance is
high. Typically, an a-error of 5% (p-value = 0.05) is assumed when calculating statistical tests. Thus, if
a significant result is achieved, there is a 5% chance that this result is considered significant although
in truth it is not. The more tests are computed, the higher the probability that some statistically
significant results are obtained by chance.

Statistically analyzing EEG / MEG data usually involves computing a large number of tests, as two or
more conditions are compared for a large number of electrodes / sensors over a time interval
containing many data samples. Therefore, the multiple comparisons problem is particularly prominent
when running statistics on EEG / MEG data.

There are different ways to address the multiple comparisons problem. The easiest is to apply the
Bonferroni correction (Abdi 2007) , where the significance level (e.g. p = 0.05) is divided by the
number of tests computed and only those tests are assumed to be significant with p-values smaller
than the corrected value. For example, if 100 tests are computed, the corrected p-value would be 0.05
/ 100 = 0.0005. This approach is very conservative and the chance is high that significant results are
wrongfully rejected. Bonferroni correction treats all data samples as independent, which is not a
correct assumption in the case of EEG / MEG data.

BESA Statistics uses an alternative approach to deal with the multiple comparisons problem: data
clustering in combination with permutation testing. The main idea is that if a statistical effect is found
over an extended time period in several neighboring channels, it is unlikely that this effect occurred by
chance. Thus, the initial step is to define data clusters that show pronounced effects in the preliminary
parametric tests. For each cluster, a cluster value can be derived consisting of the sum of all t-values /
F-values of all data points in the cluster.

Cluster Value
t=23 +t=28 +t=29 +t=32+t=38 +t=29+t=22
= 20.1

Figure 8.2a Example for how a cluster value is derived.

For t-test and correlation (not for ANOVA / ANCOVA), a statistical effect can have a direction (i.e.
condition 1 can have larger or smaller values than condition 2 or the correlation can be positive or
negative), positive and negative clusters can be found, i.e. the cluster values can also be positive
or negative. The initial clustering based on the preliminary parametric tests is followed by permutation
of the data.
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The null-hypothesis behind any kind of permutation test is the exchangeability of data (see
also: http://www.fieldtriptoolbox.org/fag/how_not_to_interpret results from_a_cluster-

based permutation_test). For t-test and ANOVA / ANCOVA, the null-hypothesis assumes that the
data of the input groups / conditions are exchangeable. For correlation it is assumed that the
assignment of the covariate per person is random and exchangeable. In other words, the null-
hypothesis in permutation testing assumes that the initial cluster values derived by the preliminary
parametric test in the recorded data are equally likely as any other cluster values derived in each
permutation step.

Permutation means that the data of subjects (for unpaired t-tests, between-group ANOVA / ANCOVAs
and correlations) or conditions (for paired t-tests or within-group ANOVA / ANCOVAs) get
systematically interchanged.

Original data Permutation 1 Permutation 2
S1_C1 S1_C2 S1_C1 S1 C2
S2_C1 S2_C2 S2_C1 S2_C2
S3 C1 S3 C2 S3_C1 S3 C2 S3_C1 S3 C2
\ J \ ) \ J
| | |
Original cluster values Derive cluster values Derive cluster values
for permutation 1 for permutation 2

Figure 8.2b Example for how data are exchanged during permutation testing when a paired t-test is used as the
input test.

Depending on the number of subjects per group / condition and the type of test, a certain number of
permutations are possible. The following example is for t-tests: If two conditions are compared in 10
subjects using a paired t-test, 1024 (2", where n is the number of subjects) permutations are possible.
If 10 subjects are compared with another set of 10 subjects for the same condition using an unpaired t-
test, 184756 ((“Ek), where n is the number of subjects in the larger group, and k is the number of
subjects of the smaller group; please note that in this example, the groups are the same size!)
permutations are possible. For each of the calculated permutations (default: 1000"), a new t- test is
computed per data-point. For each permutation, new clusters are determined and the according
cluster values are derived for each cluster. Thus, a distribution of cluster-values can be established
across all permutations. Based on this new distribution, the a-error of the initial cluster value can be
directly determined. For example, if only 2% of all cluster values are larger than the initial cluster
value, the initial cluster has a 2% chance that the null-hypothesis was falsely rejected, i.e. the data of
groups / conditions are considered un-exchangeable although in truth they are exchangeable.
Conversely, the data of groups / conditions are not interchangeable with a chance of 98%. Therefore,
the cluster is associated with the p-value 0.02 (one-sided test). Thus, based on the computed cluster-
value distribution, the probability of each initial cluster can be directly determined (see Figure 8.2c).

The same permutation logic as for the above t-test example also applies for F-tests (ANOVA /
ANCOVAs) and correlations. As the preliminary test is only used for clustering, the type of input test
does not matter. Depending on experimental design, it is still important to pick the appropriate
preliminary test.

' Drawn randomly without repetitions from all possible permutations. If there are not enough subjects to select
1000 permutations, the number is automatically adjusted to the maximum possible number of permutations.
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Figure 8.2c A realistic distribution of cluster values based on 1000 permutations is displayed. The figure indicates
that a cluster value of 300 is associated with a probability value of p=0.05 (one-sided t-test), meaning that only 5%
of all clusters have absolute values larger than 300.

Since in permutation testing the distribution of cluster values is computed from the input data, and
probability values are derived directly from the computed distribution, permutation testing is
considered non-parametric, or parameter-free. This is a great advantage, since it is not required that
data are normally distributed, as would be the case if classic parametric tests were used.

For more details on the implementation of the permutation test as implemented in BESA Statistics
please refer to the following publications: (Bullmore, Suckling et al. 1999; Maris and Oostenveld 2007;
Ernst 2004). For permutation testing in the case of correlation, see (Freedman and Lane 1983;
O’'Gorman 2012).

Important Note on the Interpretation of Clusters:

The size of a cluster depends on various factors. On the one hand it is directly influenced by the
cluster alpha value (see 12.8.2.) on the other hand it depends on factors such as signal to noise ratio,
recording modality, and analysis type. Particular caution is advised when interpreting clusters that
were derived from sensor space data. For example, sources in the auditory cortex will lead to dipolar
fields over temporal areas with a positive and a negative pole in MEG and a fronto-central negativity in
EEG. In the MEG case, it would not make sense to interpret two clusters, one in the positive and one
in the negative pole of the same dipolar field separately, as they both reflect the same underlying
activity, i.e. the auditory cortex source. In the EEG case, it does not make sense to interpret the extent
of a cluster in fronto-central sensors as again the extremely wide-spread fronto-central activity reflects
potentially very focal activity in auditory cortex that is subject to the poor conductivity of the skull
resulting in a widely distributed field potential. In the case of image data, i.e. results from distributed
source analysis like LORETA, the extent of a cluster should also be interpreted with caution as the
extent of the activity is extremely dependent on the input method. For example, an iterative approach
will lead to less wide-spread activity and in consequence clusters compared to non-iterative methods,
although they reflect the same underlying activity. Regarding the extent of a cluster in time, it should
be taken into consideration that the temporal extent of an event-related potential / field is dependent
on other factors besides the underlying activity in a cortical patch. For example, a brain response can
be more or less time-locked to a stimulus, leading to very sharp (highly time-locked) or more wide-
spread (more jitter) ERPs / ERFs, although the underlying activity might in fact be the same. Likewise,
identifying two clusters in the same ERP / ERF or source waveform cannot necessarily be interpreted
as two separate activities. They might well reflect the same underlying brain activity.
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8.3. Post-Hoc Permutation Test (non-parametric) — Scheffe’s Test

As mentioned in chapter 8.1.2.3., it is necessary to run a post-hoc test when a main effect in a one-
way ANOVA / ANCOVA with more than two groups / conditions becomes significant. BESA Statistics
uses Scheffe’s test for this purpose. Scheffe’s test computes F-values for all pairwise comparisons of
groups / conditions and determines a new critical F-value indicating, which individual pairwise
comparisons of groups / conditions are significant (for more details about Scheffe’s test theory see
(Bortz 2005). In our case, this yields new clusters that will always be sub-sets of the ANOVA /
ANCOVA clusters. As each permutation is associated with different clusters, and in consequence
different cluster F-values, Scheffe’s test must also be computed for each permutation. A new
distribution of Scheffe’s test F-values is built and p-values are derived directly from the computed
distribution as described in chapter 8.2.

As Scheffe’s test runs pairwise comparisons, the permutation test based on Scheffe’s F-values is
repeated several times (‘2‘). As an example, if 3 groups / conditions are compared, 3 permutation tests
need to be computed ((group / cond. 1 vs group / cond. 2), (group / cond. 2 vs group / cond. 3), (group
/ cond. 2 vs group / cond. 3)). In the case of 4 groups / conditions, 6 permutation tests must be run.
Thus, we are yet again faced with a multiple comparison problem. In order to correct for this, BESA
Statistics uses the Bonferroni Holm method. It is less conservative than the Bonferroni correction, but
less liberal than using no correction at all.

The following example delineates the application of the Bonferroni-Holm correction in a cluster-
permutation setting. Let us assume we ran Scheffe’s test in 3 groups, and that the following cluster
structure was revealed for the individual pairwise comparisons:

Group 1 vs. Group 2 Group 1 vs. Group 3 Group 2 vs. Group 3
p=0.01 p=0.04
p=0.02
p=0.07- n.s.
p=0.02 p=0.03
p=0.08

Figure 8.3a Clusters for pair-wise comparisons as derived by Scheffe’s test before Bonferroni-Holm correction

The first step of the Bonferroni-Holm method is to calculate the corrected p-value following
Bonferroni. As we are running 3 pairwise comparisons, we need to divide our p-value by 3 > 0.05/3
== 0.0167. We then identify the pairwise test that contains the cluster with the smallest p-value, in the
present example it is the comparison Group 1 vs. Group 2. We determine, if this comparison contains
a cluster that survives the Bonferroni correction. In the above example, the first cluster (with 6 boxes)
does (0.01 < 0.0167, see fig. 8.3b below). The other two clusters within this pairwise comparison do
not survive the Bonferroni correction and must be discarded.
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Group 1 vs. Group 2

Group 1 vs. Group 3

Group 2 vs. Group 3

p=0.01 p=0.04
p=0.02
p=0.07
p=0.02 — n.s. p=0.03
p=0.08 — n.s.

Figure 8.3b Step 1 of Bonferroni-Holm correction

The second step of the Bonferroni-Holm method takes into account that the first comparison
contained at least one cluster that survived Bonferroni correction. Therefore, the p-value is not divided
by 3 anymore, but only by 2 (3 minus 1) = 0.05/2 == 0.025. Then we identify the pairwise test with
the second-most significant cluster: in the above example this is the comparison Group 1 vs. Group
3. We determine, if this comparison contains a cluster that survives the adjusted Bonferroni correction
(p-value 0.025). In the present example, the first cluster (with 8 boxes) does (0.02 < 0.025, see fig.
8.3c below). The other cluster does not survive the Bonferroni correction.

Group 1 vs. Group 2

Group 1 vs. Group 3

Group 2 vs. Group 3

p=0.01 p=0.04
p=0.02
p=0.07
p=0.02 - n.s. p=0.03 — n.s.
p=0.08 — n.s.

Figure 8.3c Step 2 of Bonferroni-Holm correction
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The third and final step of the Bonferroni-Holm method in the present example takes into account
that two comparisons contained at least one cluster that survived the (adjusted) Bonferroni correction.
Therefore, the p-value is not divided by 3 anymore, but only by 1 (3 minus 2) - 0.05/ 1 == 0.05. Then
we check, if our last pairwise test contains clusters with an associated p-value < p=0.05. In the present
example, this applies to the first cluster (with 2 boxes) (see fig. 8.3d below). The other cluster must be
discarded.

Group 1 vs. Group 2 Group 1 vs. Group 3 Group 2 vs. Group 3
p=0.01 p=0.04
p=0.02
p=0.07 — n.s.
p=0.02 - n.s. p=0.03 — n.s.
p=0.08 — n.s.

Figure 8.3d Step 3 of Bonferroni-Holm correction

The above example demonstrates that the Bonferroni-Holm correction reduced the number of clusters
as derived by the permutation test based on Scheffe’s test. While the first pairwise test (Group 1 vs.
Group 2) originally yielded 3 clusters, now only 1 cluster remains. The second pairwise-test (Group 1
vs. Group 3) originally yielded 2 clusters: however, after the Bonferroni-Holm correction only 1 cluster
remains. In the third pairwise-test (Group 2 vs. Group 3), only the first cluster remains. This example
also shows that the Bonferroni-Holm method is less conservative than the Bonferroni correction, as
this would only have yielded one cluster in the first pairwise comparison.
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9. The Workflow Concept

BESA Statistics uses a modern workflow concept that guides you through all the worksteps needed to
complete a project, suggests and explains necessary inputs and user actions, and performs many
worksteps automatically. At any time, you may interrupt and inspect earlier worksteps or redo them
with modified input parameters if required.

File Edit View Export Help

Perform Statistics /w B ES E "

O &0 8 e

Workflow Overview -
Run Statistics ] J
Set Project Targets of
Statistical Analysis Permutation Test Results
Load Data v Val . Cluster +/-  Vis | »
% 001 [p=0.00100] - E
Set Parameters v 4 *k 002 [p=0.00100]

003 [p=0.07000]
004 [p=0.09400]
005 [p=0.09600]

Perform Statistics

T T S R

006 [p=0.12200]
007 [p=0.14800]
008 [p=0.17900]
009 [p=0.18400]
010 [n=N 240001 X2
50
i o Display Left Display Top/Right 3
Condition 1 Difference
50 Condition 2 [ t-Values
Mask [T Mask
Amplitude
Select Channel
A108 -
Mis
£ 100 £ Current Latency [ms]
S A10g = 2108 Y
2 29 — |2 16.430 I
£ 1004 \ =
: 200 &0 Set Scale
-300-
" T T T T Reset
-100 0 100 200 Latency [ms] -100 0 100 200 Latency [ms] D
Statistical calculation finished successfully. i By el
i
Scale x 1.0
I Mote: These results are corrected for multiple comparisons.
For more information about this Workstep see the Perform Statistics section in the [a |_| m =
description of the BESA Statistics Workflow.
i

A workflow consists of a series of worksteps required to finalize a project. Each workstep contains a
set of user interactions needed to achieve the workstep-specific result. Only few user interactions are
needed.

When pressing the Next button or Space, a workstep is completed and the next workstep is loaded.
Thus, the workflow of a project sequentially proceeds from workstep to workstep.

The layout of the BESA Statistics screen is optimized for this workflow concept. The workflow menu -
as shown on the left in the Workflow Window - gives an overview over all the worksteps to be
completed in the selected project (see 10.1). The workflow menu can be used to switch between the
worksteps. For example, you may redo an earlier step with different or advanced parameters and
continue with automatic processing of all subsequent steps as defined before.

The current results during a workstep are shown in the Main Window in the center of the screen (see
10.2). The Information Window below (see 10.4) provides advice and help information for the current
workstep.

During each workstep a specific dialog is shown in the Interaction Window on the right to allow for
optimized user interaction relevant for the current workstep (see 10.3). After completing all
interactions, press the Next button at the bottom or Space to proceed to the next workstep. Press
the Previous button to go back one workstep. After completing the last workstep of the workflow,
press the Finish button at the bottom of the Interaction Window to save all data created during the
project. This saving step enables reloading the full workflow of a project with all worksteps at a later
time.
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The Workflow Concept

A project is defined by a specific workflow together with the stored individual input and output

data. Stored projects can be viewed by selecting the menu item File > Open Project, by using the
open button in the toolbar, or by pressing the Open Project buttons on the start screen. After opening
a stored completed project, the final workflow result is displayed.
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10. Elements of the BESA Statistics Screen

The layout of BESA Statistics screen is optimized for the workflow concept as described in chapter 0.
The figure below shows the BESA Statistics screen with all its elements:

File Edit View Export Help

Select Project f} BES .

Ll = <l

Start Workflow ( Start New t-Test Praject ]
Select Project @ [ Start New ANOVA Project ]
[ ]

[ )

Start New Correlation Project

Open Project

O,

Select project by pressing one of the buttons in the Interaction Window.

| For more information see description of the Select Project Page_

1 Workflow Window (see chapter 10.1)

2 Main Window (see chapter 10.2)

3 Interaction Window (see chapter 10.3)
4 Information Window (see chapter 10.4)
5 Menu Bar (see chapter 11.1)

6 Title Bar (see chapter 11.2)

7 Toolbar(see chapter 11.3)

8 Caption (see chapter 11.4)
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10.1. Workflow Window

The Workflow Window on the left displays the workflow menu. The workflow menu gives an overview
over the sequential steps needed to finish the current project. Steps already completed are marked
with a green OK sign. +

The current workstep is highlighted. This step is also shown in the caption.

The workflow menu can be used like any other menu to jump to another workstep provided that the
previous worksteps have already been completed.

10.2. Main Window

The Main Window area displays the results of the current workstep. A detailed description how to use
the elements shown in this window is given in chapter 12.8.

10.3. Interaction Window

The Interaction Window provides the user interaction for the current workstep.

The upper interaction elements are used to set parameters needed in the workstep by using
standard elements like buttons, edit boxes, and sliders. The effect of changing parameters is seen in

the Main Window left of the Interaction Window.

In some worksteps, additional interaction elements are shown at the bottom of the Interaction Window
to enable changing visualization parameters.

Current parameters are accepted by typing Space, or by pressing the Next button at the bottom
prompting the workflow to proceed to the next workstep.

The Previous button is used to jump back to the previous workstep.
10.3.1. Notes

1. You can also undo or redo a workstep using the menu items Edit > Undo and Edit - Redo or by
typing Ctrl-Z or Ctrl-Y.

2. Moving on to the next workstep is fastest by typing Space or Enter.

10.4. Information Window

The information window displays a comprehensive help text related to the current workstep. The help
texts provide additional information, e.g. which file has been loaded. They suggest and explain the
next user interaction to be done in the current workstep.

Underlined text in blue provides a hyperlink. Click on such a link to open the BESA Statistics help at
the indicated topic.

Use the check boxes in Interaction Window to select the data type to be analyzed and the statistical test to be used for the analysis.
The Main Window lists the targets to be achieved by the worlflow.
To continue the workflow, you can always type Space or Enter or press the Next button.

For more information see description of the BESA Statistics Workflow.
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11. Program Bars

11.1. Menu Bar

The Menu Bar provides the menus listed below. Click on a menu to select and choose from the menu
items that pop up.

11.1.1.File Menu

The File menu contains the following items:

File menu item Description

Create New Project Start a new project.

Load an existing project. A choice can be made between project

Open Project types t-test, ANOVA, and correlation.

Close Project Close currently active project. Show the Select Project Page.
Save Save the currently active project.

Save As... Specify a filename for currently active project and save it.
Delete Projects... Select one or multiple projects that shall be.

Select the folder to be used as BESA Statistics Data Folder (see

Select Data Folder 6.3.3).

Update the information file in the BESA Statistics Data Folder (see

Update Data Folder Info 6.3.3).

Exit Terminate the BESA Statistics program.

11.1.2. Edit Menu

The Edit menu contains the following items:

Edit menu item Description
Undo Undo the last step completed in the current workstep.
Redo Redo the last step that was undone in the current workstep.

11.1.3.View Menu

The View menu can be used to change display settings for BESA Statistics. It contains the following
entries:

View menu item Description

By selecting or deselecting this menu item the Workflow Menu is

Show Workflow Window displayed or hidden (see 10.1).
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By selecting or deselecting this menu item the Information Window is

Show Information Window displayed or hidden (see 10.4).

Standard Font Size,

Larae Font Size Select one of these menu items to specify the size of the font to be
J ! used in BESA Statistics.

Extra Large Font Size

11.1.4. Export Menu

The Export menu can be used for exporting vector graphics (*.eps) or bitmap images (*.png) of the
main window, of the detail windows or of a combination of all windows. It also allows exporting the
statistical results of the permutation test either as a summary (Cluster and p-values, cluster
boundaries) or as detailed means per subject / cluster. For a more detailed description of the exporting
options please see chapter 17.

Export menu item Description

Allows exporting images of the main window, the left detail window,
the right details window or all windows. In the saving dialogue, the
format (*.eps or *.png) can be specified. Images can also be
exported by right-clicking in the according window.

Image

Allows exporting the summary of cluster statistics and detailed

Statistical Results
results per cluster. Results are saved as comma-separated values.

11.1.5.Help Menu

Use the Help menu to open the program help or to get information about BESA Statistics.

Help menu item Description

BESA Statistics Help Open the program help.

About... Get information about the current program version.
11.2. Title Bar

The title bar of BESA Statistics displays the program name and version number. In addition, it shows
information on the current project:

e Group name

e Project name

11.3. Toolbar

The Toolbar provides direct access to the most important menu items:
1 File > Create New Project

= File > Open Project
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=T File > Close Project
B File > Save Project
B Edit > Undo
‘¥ Edit> Redo

11.4. Caption

The caption is located between the Menu Bar and the Toolbar and specifies the current workstep.
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12. How to use BESA Statistics

Before working with BESA Statistics, please consult chapter 10 on the elements of the BESA Statistics
screen.

12.1. Starting BESA Statistics
12.1.1.Welcome Screen
Start BESA Statistics from its icon on the desktop.

When starting BESA Statistics, a welcome screen appears. It provides some information on the BESA
Statistics program including the current version number and date:

BESA°® Version 2.0 June 2015

- - BESA GmbH, 82166 Graefelfing, Germany
Statistics Copyright ® 2015 -all rights reserved.

icensed for use on a single computer
disclaimed, including all

software is not a clinical product. It is not allowed to
ly or indirectly for medical diagnosis andfor

For research use only!
Hot for the use in diagnostic procedures!
Please read the User Manual before first use!

linked Ot 4.7.1 libraries.
buted under the LGPL 2.1
er information.}

If you acceptthe licensing conditions, cli ept, else click 'Cancel’.

T

Press Accept to start BESA Statistics.
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The Workflow of BESA Statistics

12.2. The Workflow

Three different workflows (or projects) can be chosen: t-test, ANOVA (incl. ANCOVA), and
Correlation. Each workflow consists of specifying the experimental design, loading EEG / MEG data,
the calculation of a preliminary parametric test used for cluster-building and optionally further
specification of data regions of interest, and finally the calculation of a cluster permutation test. If an

ANOVA project is started, there is an additional workstep for post-hoc testing. The worksteps are
described in the following chapters.

12.3. Select Project — Parametric Test

In order to start a workflow for statistical analysis, a selection of the statistical project must be made:

o Start New t-test Project

o Start New ANOVA Project

¢ Start New Correlation Project

¢ Open Project
For a more detailed description of the statistical tests, please see the previous chapters 8.1.
12.3.1.Notes

Projects can also be started or opened at any time by selecting the menu items File > Create New
Project or File > Open Project.

12.4. Set Project Targets: Data Type

After selecting a statistical project, the type of data that will be analyzed needs to be specified:

e TFC (Time-Frequency and Coherence): time-frequency analysis or coherence results in
source space (TFC > SWF) or sensor space (TFC > ERP / ERF)

¢ Image: data derived from distributed source analysis(e.g. LORETA) in a volume?

o SWF (Source waveforms): data derived from discrete source analysis using single dipoles or
regional sources

o ERP / ERF: event-related potential /field data (sensor-level) obtained by averaging across trials
The required file format of the different data types is described in chapter 19.

After selecting the input data type, further specifications need to be made for the chosen statistical
test. Press Start to initialize the selected workflow or return to the workflow selection with Previous.

2 Please note that Minimum Norm solutions are calculated on a standard cortex in BESA Research. Statistical
analysis of cortex-based solutions is currently not yet supported.
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12.5. Set Project Targets for Parametric Test
12.5.1. t-test
The type of t-test that will be used as the base for permutation testing needs to be set (see 8.1.1):

¢ Paired t-test: In case two conditions are compared within the same subjects, a paired t-test
should be selected. E.g. The EEG of 10 subjects was measured while they were listening to
tones of high and low frequency. The brain response to tones of high frequency will be
compared to the brain response to tones of low frequency within the same 10 subjects.

¢ Unpaired t-test: In case two groups of subjects are compared for the same condition, an
unpaired-t-test should be selected. E.g. the EEG of a control group and a patient group is
measured while subjects are viewing pleasant pictures. The brain response to pleasant
pictures will be compared between control subjects and patients.

o Two-tailed, one-tailed left, one-tailed right: Generally speaking, the likelihood to obtain
significant results is higher if a specific hypothesis about the data is tested. In case there is no
specific hypothesis as to whether one group/condition has higher / lower values than the other
group/condition, a two-tailed t-test should be selected. In case there is the hypothesis that the
first group / condition has higher values than the second group / condition, a one-tailed-right t-
test should be selected. In case there is the hypothesis that the second group / condition has
higher values than the first group / condition, a one-tailed-left t-test should be selected.

12.5.2. ANOVA

The type of ANOVA that will be used as the base for permutation testing needs to be selected (see
8.1.2):

¢ Univariate ANOVA Within-Group: In case more than two conditions are compared within the
same subjects, a univariate within-group ANOVA should be selected. E.g. the EEG of the
same 10 anxiety patients was measured before, directly after and 1 month after an anti-
anxiety training. The research question is, which, if any, brain regions, EEG / MEG sensor
measurements, and / or time-frequency regions are sensitive to the influence of the training.

o With Covariate of no Interest (ANCOVA): In case there is a variable that also
influences the dependent variable and co-varies with the independent variable in an
undesired fashion, a covariate of no interest can be entered in the ANOVA. E.g. the
blood cortisol level was measured per person at each of the three time-points in
the above experiment, and may have an influence on the subject’s response value,
which we have no interest in within the framework of our research question. Blood
cortisol level can then be used as the covariate of no interest.

¢ Univariate ANOVA Between-Group: In case one condition shall be compared between more
than two groups of different subjects, a univariate between-group ANOVA should be selected.
E.g. The EEG was measured in 10 control subjects, 15 patients with depression, and 12
patients with schizophrenia while they were presented words with affective content. The
research question is, which brain regions, EEG / MEG sensor measurements, and / or time-
frequency regions differentiate between controls, depressed and schizophrenic patients in
emotion processing.

o With Covariate of no Interest (ANCOVA): In case there is a variable that also
influences the dependent variable and co-varies with the independent variable in an
undesired fashion, a covariate of no interest can be entered in the ANOVA. E.g. the
blood cortisol level was measured per person for each of the three groups in the
above experiment, and may have an influence on the subject’s response value, which
we have no interest in within the framework of our research question. Blood cortisol
level is then the covariate of no interest.
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12.5.3. Correlation

Correlation can be computed between data of one group / condition and one covariate of interest (see
8.1.3). The t-value associated with the correlation coefficient will then be used as the base for
permutation testing. For example an MEG component in 15 subjects can be correlated with the results
of an attention test.
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For more information about this Workstep see the Perform Statistics section in the =
o |
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12.6. Define Experimental Design

In this workstep, the experimental design must be specified further in case an ANOVA or correlation
project was started. This step is not required for t-test. The interaction window is sub-divided into 3
boxes. The top box gives an overview of the selected data type and statistical test. The middle box
includes the experimental design, the bottom box includes the factor level names.

12.6.1. Within-Group ANOVA
For Experimental Design, the following input has to be provided:

¢ Number of Within-Group Factor Levels: The number of conditions that shall be compared
within the same set of subjects is provided here. E.g. The EEG of the same 10 anxiety
patients was measured before, directly after and 1 month after an anti-anxiety training. In this
case, the number of factor levels is 3.

¢ Number of Subjects: The number of subjects, i.e. datasets per factor level, is specified here.
Only one number can be entered, i.e. the number of subjects must be identical for all factor
levels / conditions and the subjects have to be the same.

For Factor Level Names, the following input is expected:

¢ Group Name: A name should be entered that describes the subjects best. E.g. the group name
could be “Anxiety Patients”.

¢ Condition 1 through n: Names should be provided for all factor levels / conditions. E.g.
Condition 1: “Before treatment”; Condition 2: “1 day post-treatment”; Condition 3: “1 month
post-treatment”

File Edit View Export Help

Define Experimental Design /w B ESA

N E 0 8 » «

Workflow Overview

Define Experimental Design Selected Data Type

Set Project Targets 4 and Statistical Test
Number of Within-Group

Statistical Analysis Factors: Number of repeated ERP / ERF = MEG

measures

Define Experimental Design Univariate ANOVA
Number of Covariates of no ‘Within-Group (repeated
Interest: Currently restricted measures)
to one at a time Without Covariate

Group Name: Choose an

attribute that is common to Define Experimental Design
all within-groups (e.g.
Patients Number of Within-

. Group Factor Levels
Within Factor Names:
Choose names representing Number of Subjects 10
your repeated measures
(Recording 1, Recording 2...)
Covariate of No Interest: Factor Level Names
Choose a name that
describes your covariate of Group Name  Anxiety Patients
no interest (e.g. Anxiety

level)
Condition 1 3efore Treatment

Condition 2 1 day post

Condition 3 1 month post

Use the check boxes in Interaction Window to specify your experimental design.
The Main Window lists the targets to be achieved by the workflow.
To continue the workflow, you can always type Space or Enter or press the Next button.

For more information see description of the BESA Statistics Workflow. i =
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12.6.2. Within-Group ANCOVA

The same input has to be provided as for Within-Group ANOVAs (12.6.1). Additionally, the following
information is entered for Experimental Design:

¢ Number of Covariates of no Interest: Currently restricted to 1.

For Factor Level Names, the following input is expected:

e Covariate of no Interest: A name should be provided that describes the covariate whose
influence will be subtracted from the data. E.g. “Blood cortisol level”

12.6.3. Between-Group ANOVA
For Experimental Design, the following input has to be provided:

¢ Number of Between-Group Factor Levels: The number of groups that shall be compared for
the same dependent variable is provided here. E.g. The EEG of anxiety patients, depressed
patients and control subjects was measured while reading emotionally charged words. In this
case, the number of factor levels is 3.

¢ Number of Subjects per Group: The number of subjects per group, i.e. datasets per factor
level, is specified here. The number of subjects can be different for all factor levels /
conditions and the subjects cannot be the same per group.

For Factor Level Names, the following input is expected:

¢ Study Name: A name should be entered that describes the experiment best. E.g. the study
name could be “Affective processing”.

o Between Group 1 through n: Names should be provided for all factor levels / groups. E.g.
Group 1: “Depression; Group 2: “Anxiety”; Group 3: “Control”

12.6.4. Between-Group ANCOVA

The same input has to be provided as for Between-Group ANOVAs (12.6.3). Additionally, the following
information must be entered for Experimental Design:

¢ Number of Covariates of no Interest: Currently restricted to 1.

For Factor Level Names, the following input must is expected:

e Covariate of no Interest: A name should be provided that describes the covariate whose
influence will be subtracted from the data. E.g. “Blood cortisol level”

12.6.5. Correlation
For Experimental Design, the following input has to be provided:
o Number of Subjects: The number of subjects, i.e. datasets, is specified here.

For Factor Level Names, the following input is expected:

e Covariate of Interest: A name should be provided that describes the covariate that will be used
for the correlation analysis. E.g. “Number of correct trials”
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12.7. Loading Data

It is recommended that the data that are to be analyzed by BESA Statistics are organized into
separate folders, one folder per condition / group containing as many files as there are subjects.
One of the data folders needs to contain 1 copy of the additional file required for ERP / ERF,

TFC and SWF data. (see 12.7.4).

Pressing the first Load Data... button will bring
up a file selector box. A group and a condition
name need to be specified before loading the
data of the first group / condition.

The file names will be listed in the Main
Window along with the specified group and
condition name. A green tick-mark will be
displayed next to the Load Data button in case
the data were successfully loaded. Type Space
or press Next, or the next Load Data button to
continue the workflow. In case a paired t-test
was selected previously only the second
condition name can be entered in the dialogue,
the group name will remain fixed. If an unpaired
t-test was selected previously only the second
group name can be entered, the condition
name will remain fixed. After loading all
required data, the Loading Data workstep is
complete.

12.7.1.Loading paired t-test data
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In case a paired t-test project was started, data files for condition 1 will be loaded in the first step, and
data files for condition 2 will be loaded in the second step. There needs to be one data file per person
per condition. The number and order of files in both conditions needs to be the same (see 12.7.a). In
case an unpaired t-test project was started, the order and the number of files do not have to be the
same for both groups of data, but need to originate from different subjects.
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It is crucial for paired T-tests that the same number of files is loaded for both conditions and

that the order of the files is the same for both conditions!

Correct Incorrect
Data Cond. 1 Data Cond. 2 Data Cond. 1 Data Cond. 2
Subject 1 Subject 1 Subject 1 Subject 3
Subject 2 Subject 2 Subject 2 Subject 1
Subject 3 Subject 3 Subject 3 Subject 2
Subject 4 Subject 4 Subject 4 Subject 4
Subject n Subject n Subject n

Box 12.7.a Data Organization for paired t-tests

12.7.2. ANOVA / ANCOVA

If an ANOVA was selected, the Load Data... buttons will already be named in line with the user input
in the previous step Design Experimental Paradigm. The number of Load Data... buttons depends

on the number of factor levels.

| T
Eile Edit View Export Help
Load Data ’W B ESA
NES A = -
Workdlow Oveniew Subject Condition 1| | Subject Condition 2| | Subject| Condition 3 Load Data for In l
Set Project Targets 4 N In Nr. Mis Nr. Del Load Data for Mis
Statistical Analysis 1 1 1
Define Experimental Design o 2 2 2 Load Data for Del
Load Data 3 3 3 Accept Data Order
4 4 4
5 3 5
6 6 6
7 7 7
3 8 8
9 9 9
10 10 10
il 1 "
12 12 12
13 13 13
14 14 14
15 15 15
Specify group and conditions for group 1.
12.7.2.1. Loading within-group ANOVA data

A

In case a within-group ANOVA project was started, data files for condition 1 will be loaded in the first

step, data files for condition 2 will be loaded in the second step, and data files for condition n will be

loaded in the n'" step. There needs to be one data file per person per condition. The number and order

of files in all conditions needs to be the same (see Box 12.7.b). In case a between-group ANOVA
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project was selected, the order and the number of files do not have to be the same for the different

groups of data.

Box 12.7.b Data Organization for a within-group ANOVA with 3 factor levels

After loading the data, the table in the
Main Window will be filled with the file
names. The table allows a quick check if
the file order is correct or needs
adjustment.

In case the file order is incorrect, it is
possible to move individual files within the
according column by clicking on the file
name and using the arrow buttons to
move the content up or down.
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12.7.2.2. Loading ANCOVA data

If an ANCOVA project was selected, additional Load Data... buttons will be present for the covariate
of no interest. In the first step, data for the first covariate of no interest are loaded. In the second step
data for the first factor level are loaded. In the third step data for the second covariate of no interest
are loaded, in the fourth step data for the second factor level are loaded, etc.

Please note that for both, within and between-group ANCOVAs there need to be separate text files
for each factor level. The file containing the covariate of no interest needs to contain 1 column with 1
numerical value per ling, i.e. one value per person (see Box 12.7.c). If a between-group ANCOVA is to
be computed for 3 groups, there need to be 3 text-files containing the covariate of no interest, one file
for each group. Likewise, if a within-group ANCOVA is to be computed for 3 conditions, a separate
text-file containing the covariate of no interest must be available for each of the 3 conditions. The
individual files containing the covariate of no interest must have different content. As an example, if
depressed patients, anxiety patients and control subjects are to be compared before, immediately after
and 1 month follow up of a treatment, it is not possible to use “age (in years)” as the covariate of no
interest, as it would be the same for all 3 factor levels. If “blood cortisol level” was measured
separately per test time-point, it could be used as the covariate of no interest (see also the chapter on
ANCOVA 8.1.2).

The order of the files for a factor level and the order of the entries of the text-file containing the
covariate of no interest have to be the same (see Box 12.7.c).

Correct Incorrect
Data Factor Data Covariate Data Factor Data Covariate
Level n of no Interest n Level n of no Interest n
Subject 1 Subject 1 Subject 1 Subject 3
Subject 2 Subject 2 Subject 2 Subject 1
Subject 3 Subject 3 Subject 3 Subject 2
Subject 4 Subject 4 Subject 4 Subject 4
Subject n Subject n Subject n

Box 12.7.c Data Organization for ANCOVAs

After loading the data, the table in the Main Window will be filled with the file names and the entries of
the covariate files (see 12.7.2.1). The table allows a quick check if the file order is correct, or whether it
needs adjustment. In case the file order is incorrect, it is possible to move individual files or covariate
entries within the according column by clicking on the file name and using the arrow buttons to move
the content up or down (see 12.7.2.1).

12.7.3.Loading Correlation Data

If a correlation project was selected, the Load data... buttons will already be named in line with the
user input in the previous step. In the first step data for the Covariate of Interest will be loaded, in the
second step EEG / MEG data for all subjects will be loaded.

The order of the files containing the EEG / MEG data and the order of the entries of the text-file
containing the covariate of interest have to be the same (see Box 12.7.d).

38



11 BESA

The Workflow of BESA Statistics

Correct Incorrect
EEG / MEG Data Covariate EEG / MEG Data Covariate
Data of Interest Data of Interest

Subject 1 Subject 1 Subject 1 Subject 3
Subject 2 Subject 2 Subject 2 Subject 1
Subject 3 Subject 3 Subject 3 Subject 2
Subject 4 Subject 4 Subject 4 Subject 4
Subject n Subject n Subject n

Box 12.7.d Data Organization for Correlation

After loading the data, the table in the Main Window will be filled with the file names and the entries of
the covariate file (see 12.7.2.1). The table allows a quick check if the file order is correct, or whether it
needs adjustment. In case the file order is incorrect, it is possible to move individual files or covariate
entries within the according column by clicking on the file name and using the arrow buttons to move
the content up or down (see 12.7.2.1).

12.7.4.Loading Data that were created in BESA Research

BESA Statistics expects the loaded data to conform to a certain format. Data that were created in
BESA Research automatically follow the format requirements if they are exported the following way:

Data Type Extension Description Data export from BESA Research
TFC ERP/ * tfc File containing results ~ TFC Window: File / Export to ASCII File >
ERF from TFC analysis on  Time Frequency Data Files
sensor level
Additional *.elp Electrode positions Main Window: File / Head Surface Points and
File Sensors / Save all Files in Head
Coordinates?
TFC SWF * tfc File containing results ~ TFC Window: File / Export to ASCII File >
from TFC analysis on  Time Frequency Data Files
source level
Additional *.bsa Source positions SA Window: File / Save Solution As - BESA
File Solution — Unit Sphere®
Image *.dat File containing solution SA Window: Image / Export Image As >

from distributed source

3 The sensor / source positions only need to be saved once per experiment, assuming that the same positions are
used for all participants. Source orientations may differ across subjects as BESA Statistics does not display
source orientations. BESA Statistics will use the first elp / bsa-file detected in the specified data folders.
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analysis Image ASCII Files (optional: - all latencies)
SWF * swf File containing solution SA Window: File / Save Source Waveforms
from discrete source As > BESA Source Waveforms Files
analysis
Additional *.bsa Source positions SA Window: File / Save Solution As > BESA
File Solution — Unit Sphere*
ERP / ERF *.avr File containing event-  Main Window, marked segment: File / Export
related potential / field - Marked segment, ASCII Vectorized®
data
Additional *.elp Electrode positions Automatically exported with ASCII Vectorized
File data®
Covariate * txt File containing 1 No export from BESA Research.

column with 1
numerical value per
line (=subject)

12.7.5.Loading data that were created in other software

Data exported from Brain Vision Analyzer 2 (ERP and time-frequency data with the extension *.vhdr,
*.vmrk, *.dat) can be read directly by BESA Statistics.

In case BESA Statistics is used for analyzing data created in other software, it is important to ensure
that files are prepared to meet file format expectations. Please see chapter 19 for a detailed file format
description.

12.8. Set Parameters, Preliminary Test

After successful loading of the data, the next workstep is Set Parameters. In order to access the
parameter settings, the Preliminary Test (8.1) as defined in Project Targets (12.5) has to be run.
Please note that results of the parametric preliminary test should not be interpreted in any way. The
preliminary probability distribution is required for cluster-building. Parameters for clustering that will be
used in the subsequent permutation test can be set in this workstep. They are to some degree
dependent on the input data type (ERP / ERF, Image, SWF, TFC ERP / ERF or TFC SWF). In the
following section, the elements of the Interaction Window will be described.

4 Coordinates must be in unit sphere. Talairach coordinates are not yet supported.
5 Only segmented data are supported, continuous data cannot be analyzed in BESA Statistics.

6 In case bad channels were defined, data were re-referenced or in case a montage was used that only contained
a subset of channels, please refer to chapter 18.1
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12.8.1. Starttime, Endtime (Start Frequency, End Frequency)

Editing the Starttime and Endtime and if applicable Start
Frequency and End Frequency, the original data epoch will be
adjusted accordingly.

Defining a region of interest can increase the chance that a
cluster will be significant after permutation. It will not alter the
significance of the target cluster per se unless the selected
starttime (frequency) / endtime (frequency) cut the cluster
boundaries. Instead, the cluster value of the target cluster will
have a different relative position in the cluster value distribution
as derived by permutation (see 8.2) when a smaller region of
interest is used.

If averages over time are computed, the starttime and endtime
selection will impact on the permutation test result.

12.8.2. Statistical Settings

The Neighbor Distance (circle arc length between two points,
only available for sensor space data, i.e. ERP / ERF and TFC
ERP / ERF) should be set to reflect the spacing between
electrodes / MEG sensors. If the value is set correctly, BESA
Statistics will only treat those electrodes / sensors as neighbors
that are directly neighboring. If the value is set too low, no
spatial clustering will be possible. If the value is set too high,
clusters might become larger as also more distant electrodes /
sensors are treated as neighbors. For image data, the
neighborhood structure is given for a volume image consisting of
adjacent voxels. l.e. the neighborhood information is
automatically retrieved by BESA Statistics! For SWF data,
no neighbor distance can be specified. The reason is that
single dipoles and regional sources are discrete entities, i.e. they
represent separate brain regions differing from each other in
their activity pattern. Clustering them in space would destroy the
advantageous property of discrete sources to separate brain
regions.

Cluster Alpha determines the significance level for building
clusters in time and / or space / frequency (see below). As the
preliminary test is run point-wise, every data point will be
associated with a p-value. BESA Statistics looks for data
clusters where the null-hypothesis can be rejected, i.e. only
those data points are eligible to be part of a cluster, which fall
below the Cluster Alpha value. Please note that the Cluster
Alpha value is not the significance level for the permutation
test! It is only used for clustering. The larger the Cluster Alpha
value, the larger the clusters.

Number of Permutations determines, how many of all possible
permutations (see 8.2) will be computed. If the number is
smaller than the number of possible permutations, permutations
are determined randomly, no repetitions allowed. If the number
is larger than the number of possible permutations, BESA
Statistics automatically corrects the value down to the maximum
amount of possible permutations.

It is possible to Average over Time and / or Frequency

Starttime [ms]

200000 (€] ]
Endtime [ms]
500.000 €]
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s000 (€]
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46000 [<€]
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/ Channels if desired. If selected, BESA Statistics will average
across all available data-points of the selected dimension.

Display Left defines what will be displayed in the left Detail
Window. Display Top/Right defines what will be displayed in
the Main Window and the right Detail Window (10.2).

Select Channel allows the selection of a desired channel (TFC
(ERP / ERF)) / source ((TFC) SWF) or maximum (Image) to be
displayed in the Detail Windows via a drop-down menu.
Alternatively, the channel / source / maximum of choice can be
selected in the Main Window by a left-click. The arrow buttons
left and right of the channel selector box can be used to quickly
browse through all channels / sources / maxima.

Current Latency allows setting a cursor at a particular latency
(if TFC data are available, a Current Frequency can be
selected additionally). The slider can be dragged to the point of
interest or the arrow buttons at the left and right of the slider bar
can be used to adjust the position.

Set Scale (only ERP / ERF) allows adjusting the scaling of the
topographic map in the Main Window. For t-test, the map
corresponds to either the difference between conditions or the
corresponding t-values, depending on the selection under
Display Top/Right. For ANOVA / ANCOVA, the map
corresponds to either F-values or the average of the input
groups / conditions. For Correlation, the map corresponds to
either r-values or the average of the input condition. A Reset
button is available to return to default settings.

Scale allows altering the scaling of the data. The arrow buttons
at the left and right of the slider bar can be used to scale the
data up or down.

Zoom allows viewing the Main Window contents in greater
detail. The arrow buttons at the left and right of the slider bar can
be used to adjust the zoom factor. The black frame at the left of
the Zoom slider displays the position of the currently displayed
window fraction relative to the complete window. The frame can
be left-dragged to another relative position. Alternatively, it is
possible to left-drag the Main Window while holding down the
control key.
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The Workflow of BESA Statistics

[ e s 20 e )
File Edit View Export Help
Set Parameters ' r} B E SA
DEDTE e a
Workflow Overview -
[ Run Preliminary F-Test ] J T
Set Project Targets of
Statistical Analysis Starttime [ms] D
-100.270
Define Experimental Design v
Endtime [ms]
Load Data 4 797735 B!
Set Parameters
Statistical Settings
Neighbor Distance
[cm] 4.00
Cluster Alpha 0.050
Number of
254 Permutations 1000 3
0 [Z] Average over Time
["]" Average over Channels
2254
F-Values Display Left Display Top/Right
[Conditions '] [F—Values ']
o R EEINED Select Channel
ER e e [€][a100 -
< /i T
£ -
L4100 \/ 104 /J\ Current Latency [ms]
700 0= = 277217 u;
-100 0 100200300 Latency [ms] -100 0 100200300 atency [ms]
Set Scale
A\ Reset
Preliminary statistics computed Suctessfully. D
For more information about this Waorkstep see the Set Parameters section in the desciiption Display Settings
of the BESA Statistics Workflow. EEVES T =2
s

The Main Window shows the
result of the statistical analysis
(t-values, F-values, r-values)
per time-point and channel
(ERP / ERF), time-point and
voxel (image), time-frequency
point and channel / source
(TFC ERP /ERF or SWF) or the
source positions if source
waveforms are analyzed.

The left Detail Window displays
an overplot of groups /
conditions of the selected
channel (ERP / ERF), voxel
(image), source (SWF). For
TFC data, only one group /
condition can be displayed at a
time. If selected, masks
indicating significant clusters
determined from the preliminary
test will be overplotted
additionally.

The right Detail Window
displays either the difference
between conditions or the
corresponding t-values (i-test),
F-values or the average of the
input groups / conditions
(ANOVA / ANCOVA). For
Correlation, the map
corresponds to either the r-
values or the average of the
input condition.
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12.9. Perform Statistics

Pressing Run Statistics opens a window with a
summary of the Statistical Settings. If applicable,
it displays the number of neighbors found with
the given neighbor distance (12.8.2). Further, the
cluster alpha value is displayed, as well as the
number of permutation. If these values need
changing, it is possible to return to the Set
Parameters workstep by pressing Cancel and
the Previous button. Confirming the summary
window with OK will start the permutation test.
Please note that depending on the number of
subjects, electrodes / sensors and data
points, the computation might take several
minutes.

-
{7 BESA Statistics =5
The settings for running the permutation test are as follows:
_LS The channel distance is 3.5 cm resulting in an average of 6.16216

neighbars per channel.
The cluster alpha used for cluster building is 0.05.
The number of permutations is 1000.
Press OK to accept the settings or Cancel in order to modify.

Results of the permutation test will be displayed optimized for the data type in the Main Window and

the Detail Windows.

7 854 Statistics 20 - Sabstcal

Fle Est vew Eot Hep
Perform Statistics
LY
Worklow Ovenien,

ot Projoct Tagots

Display Settings

Scalex21

< 0 B3
OFt s
Proiovs ] (Fwn )

Perform Statistcs

E

ot Scale

Reset] (€

Display Settings

Gurent Latency [ms]

Perform Statistics N BES‘ ‘
o E e ’

<<
.
.
.
.
.
.
.
°e

Salct Soures.

[ T—

nnnnn Latency ms]

Curent
e (€1 D]

St Scale Dot Window
(Resn) (€

0} 2]

Perform Statistics.

EELL)

™

7]

Figure 12.9.1 Visualization of significant data clusters obtained by permutation statistics
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The Workflow of BESA Statistics

Permutation results are data clusters that are now
associated with a specific p-value. Up to 100 data

Permutation Test Results

clusters are listed. Significant clusters are labeled Val . | Cluster +- | Vis | »
with stars in the first column of the permutation Jedk 001 [p=0.00000] + |
results: * 002 [p=0.01000] + =
- 003 [p=0.01000]  +
* 004 [p=0.01000]  +
* 005 [p=0.02000]  +
+ 006 [p=0.03000]  +
007 [p=0.06000]  +
008 [p=0.06000]  +
009 [p=0.09000]  + il
AN Te=N 2000001 —
One-tailed t-test, ANOVA / ANCOVA, Correlation | Two-tailed t-test
* % x: p-values < 0.001 * % x: p-values < 0.0005
* % p-values < 0.01 and = 0.001 * % p-values < 0.005 and = 0.0005
*: p-values < 0.05 and = 0.01 *: p-values < 0.025 and = 0.005
+: p-values < 0.1 and 2 0.05 +: p-values < 0.05 and = 0.025
If there is more than one cluster in the same T-Values
category, clusters will have a different color to make § 10-
them distinguishable. g g
i
.Y . 0
Clusters can be positive or negative (see 8.2) and 5 Y
are accordingly labeled “+” or “- in the third column 10-
of the permutation results. For ANOVA /| ANCOVA, | . .
clusters can only be positive as there are only 0 50 100 Latency [ms]
positive F-values.
Clusters can be selected to be visualized in the ]
Main Window by setting a green tick-mark in the _ R
fourth column of the permutation results. Only £ 40 By 40-
selected clusters will be displayed. 5 20-
o L
Positive clusters (see 8.2) are marked by light red g 20- -20
bars (ERP /ERF, image, SWF) or voxel masks L o i
(TFC). Negative clusters are marked by light blue T-Values

bars or voxel masks (TFC) in the Detail Windows.
The currently selected cluster is colored dark red
or dark blue.

] 250 Latency [ms]

The remaining settings in the Interaction Window are analogue to the Set Parameters worksteps
(12.8) with the difference that “Mask” now only refers to selected clusters to be visualized.

Pressing Finish saves the current project.
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The Workflow of BESA Statistics

After specifying a group and project name, projects including
all completed workflows steps will be saved and marked with a
green arrow. Completed, but not finished projects are marked
by a green dot. Incomplete projects are marked by a red dot.

A project can be re-opened at any time by pressing File /
Open Project

.|
12.10. Post-Hoc Testing — ANOVA / ANCOVA only
After finishing the Perform Statistics workstep in the :
ANOVA / ANCOVA workflow and (only) if clusters Workflow Ovenview
were identified that reject the null-hypothesis of Set Project Targets v
exchangeability of groups / conditions, i.e. that show
a significant main effect in the ANOVA / ANCOVA, it Statistical Analysis
is necessary to run post-hoc tests in order to find out, Define Experimental Design v
which pairwise comparisons were responsible for the
main effect (8.1.2). Load Data v
. . Set Parameters of
Pressing Run Post-Hoc Tests will initialize the
computation of pairwise comparisons with Scheffe’s Perform Statistics v
test (8.3). Post-hoc testing also follows the cluster- Post-Hoc Statistics
permutation logic (8.2). Therefore, a permutation test
is computed for each pairwise comparison, the
significance level being adjusted following Bonferoni-
Holm (8.3). Please note that computation might take
a while, depending on the number of pairwise [ Run Post-Hoc Tests |
comparison and data size.
Results for_the Post-H_oc tests can be displayed ft_Jr [ T—Te——T——— |
each pairwise comparison following the same logic
as described in the Perform Statistics workstep
(12.9).
Pairwise Comparison
Condition 1 vs. Condition 3 -
Permutation Test Results for
Selected Pairwise Test
Wal . | Cluster +- | Vis | =
Hh 001 [p=0.00000] +
% 002 [p=0.00300] + |
- 003 [p=0.01300] + 3
* 004 [p=0.02300] +
* 005 [p=0.02800] +
* 006 [p=0.04700] +
007 [p=1.00000] +
008 [p=1.00000] +
009 [p=1.00000] +
A4 Tn=1 ANAANT + il
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File Edit View Export Help

Post-Hoc Statistics

i

EE = a

' 1YBESA

Workflow Overview
Set Project Targets

4

Statistical Analysis
Define Experimental Design
Load Data
Set Parameters

Perform Statistics

LA 4

i

Post-Hoc Statistics

P val - [Cluster [+~ [Vis o
==l Fokk 001 [p=0.00000] +
* 002 [p=0.02000] + o
003 [p=1.00000] +
004 [p=1.00000] +
F-‘alues
Display Left Display Top/Right
[Condltlons V] F-Values A
Yeres
V] F-Values
- \J_] Difference
e Select E)clrem (F-V: ) Mask
LJ!J

0
0
-10

Current Latency [ms]

Mis F-alues
= 2
s =
= I
R R E— -
= 20
=
=
- Latency [ms] Latency [ms]
Statistical calculation finished successfully. é

Mote: These results are corrected for multiple comparisons.
For more information about this Workstep see the Perform Statistics section in the
description of the BESA Statistics Workflow.

278.720 1 )
Set Scale

Reset D @
0] >
X Coordinate (TAL) 385 )
Y Coordinate (TAL) 16.9 (2]
Z Coordinate (TAL) 43 3]

Set Scale Detail Window

et € 0O

In the drop-down menu Display Top/Right, it is now possible to either select F-values for the current
pair-wise comparison or Difference in order to display the mean difference between the input groups /
condition of the current pair-wise comparison.
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13.
13.7. Load Data

When ERP / ERF data are loaded, BESA Statistics expects
the file format *.avr (see 12.7.4) or the format *.vhdr for data
created in BrainVision Analyzer 2.

Please note that in case EEG or MEG data data in the *avr
format are analyzed, one of the folders must contain a
channel position file (*.elp, see 12.7.4).

13.8. Set Parameters

The Neighbor Distance should be specified according to the
current channel layout. As different EEG caps will have a
different number of electrodes with different mean distances,
each electrode cap will require a particular Neighbor Distance.
The same is true for MEG systems. The summary window in
the Run Statistics worstep allows inspecting the correctness of
the Neighbor Distance.
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[ {2 Controls/Cond. 1 ===
Lookjn . Cond 1 . @d o
Name Date modified
= Slaw 28102011 2026
el S2avr 28102011 2026
Stawr 28102011 2026
Lo Sta 2102011 2027
Deskiap Ssawr 28102011 2027
Séawr 28.10.2011 2027
- S7aw 28102011 2027
Libraries Savr 28102011 20:27
A S9awr 28102011 2027
- 5104w 28102011 2027
Computer
QD e
Files of type: ERP Files (".avr) Cancel
[ ol
Statistical Settings
Meighbor Distance — —
[C m] < 3.0 >
Cluster Alpha £ 0.050 [
MNumber of —
Permutations <] 1000 [ >

[] Average aver Time

[] Average aver Channels
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13.9. Perform Statistics

77 BESA Statistics 2.0 - Statist
Eil

le Edit Wew Expot Help

Perform Statistics /W BESA
DEDEw A .‘

Waorkflow Overview

>

[ Run Statistics 1 « B

Set Project Targets of
Statistical Analysis Permutation Test Results
Load Data o
Set Parameters s

[ Perform Statistics }

Val Cluster +- |Vis | =
sk 001 [p=0.00000] t W |E|
*k 002 [p=0.00100] b
k003 [p=0.00300]
* 004 [p=0.00800]
005 [p=0.05600]
006 [p=0.05800]
007 [p=0.11400]
008 [p=0.44100]

009 [p=0.47100]
N0 In=0 RARNNT

[

m

Display Left Display Top/Right
Condition 1 ["] Difference
5] Condition 2 t-Values
Mask Mask

Select Channel

oz a Current Latency [ms]

J 364.000 il

[\
\, CANTT ey
U U Set Scale

250 0 280 Lstency [ms] 250 0 280 Latency [ms) 0

High Lowe t-Yalues
2" aw

tvalues

A
‘vvv = il

Amplitude [pv]
(=]

Statistical calculation finished successfully. Display Settings

] »

. . Scale x 1.0
Mote: These results are corrected for multiple comparisons. 1
For more information about this Workstep see the Perform Statistics section in the m H m 2

description of the BESA Statistics Workflow. il

When analyzing sensor space data, the permutation test can Permutation Test Results
reveal several clusters where the null-hypothesis must be
rejected, i.e. the groups / conditions / subjects are not
interchangeable. Please note that it is possible that different
clusters may reflect the same underlying effect, e.g. the
positive and negative field resulting from underlying dipolar
activity of the same generator inside the brain. These clusters
should not be interpreted separately (see Important note
on the Interpretation of Clusters in chapter 8.2).

Val Cluster +- |Vis | =
ok 001 [p=0.00000] Y
Yok 002 [p=0.00100] -
b 8.1
w

[

003 [p=0.00300] -

£ £ £

[
[
004 [p=0.00800] -
005 [p=0.05600] -
006 [p=0.05800] +
007 [p=0.11400] -
008 [p=0.44100] +

009 [p=0.47100] -
MM [n=N FARNNT -
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14. Specific Issues when Analyzing Source Waveforms

14.1. Load Data

When source waveform data are loaded, BESA Statistics E— —
expects the file format *.swf (see 12.7.4). o
'l S
oot s
Please note that when SWF data are analyzed, one of the '! e
folders must contain a source position file (*.bsa, see
12.7.4). S Y =
Files of type: Sowrce Waveform Files (" swl) z Cancel

14.2. Set Parameters

No Neighbor Distance can be set as individual sources are thought to reflect activity in discrete
cortical patches. Grouping discrete sources would lead to misleading results. Thus, clusters will only
be built within each individual source. Please note that each orientation of a regional source is
considered as a separate source, as each orientation represents a different cortical patch as illustrated
in the example below.

dipole orientation identifies cortical surface !!

lateral
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14.3. Perform Statistics

(7 BESA Statistics 2.0 - Ney

File Edit View Export Help

Perform Statistics — /j B ESA

DEDE »

Workflow Overview [ Run Statistics J J
Set Project Targets of

Statistical Analysis
Load Data L4 e ]

Set Parameters of - ®
® L y me | 45 / Permutation Test Results

Perform Statistics

a

L ST RN RE.

Wal .| Cluster Vis
Fkk 001 [p=0.00000]
Jok 002 [p=0.00200]
Jk 003 [p=0.00400]
004 [p=0.07700]

- 005 [p=0.13300]
. / P . 006 [p=0.13900]
® vare / e @ 007 [p=0.16200]
° O O 008 [p=0.16800]

009 [p=0.18200]

040 [n=0 193001

] »

Display Left Display Right
Condition 1 [”] Difference
Condition 2 t-Values

' In Mis t-Yalues Mask [ Mask

25 Reiz-0
0 M

t-Yalues

24 R513-0

I [b—\"/\_,\ Select Source

t RS-3-01 -
NEILE S cme o>

: I ; T Current Latency [ms]
000 100200300 Latency [ms] 100 0 100200300 Latency [ms] 123.863 [}

Amplitude [nAm]

»

Statistical calculation finished successfully.

Set Scale Detail Window
Mote: These results are corrected for multiple comparisons.

O 0
For more information about this Workstep see the Perform Statistics section in the
description of the BESA Statistics Workflow. i

Permutation test results will be clusters where the null-hypothesis is rejected, i.e. data are not
interchangeable. By default, BESA Statistics automatically selects the cluster and the corresponding
source / orientation with the largest T-/F-/R- value for visualization in the Detail Windows.
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15.

Start BESA Statistics and press Start new Project.

15.1. Set Project Targets

It is possible to analyze TFC results based on source
montages (SWF) or based on channels in sensor space (ERP
/ ERF). If the latter is selected, it is necessary to choose
between EEG, MEG, intra-cranial (ICR) and polygraphic data
(POL).

15.2. Load Data

If TFC analysis is performed on ERP / ERF EEG and MEG
data files that were created by BESA, the data should be
associated with a channel position file (*.elp, see 12.7.1)
so that BESA Statistics can display the channels at their
correct position and also retrieve the correct neighborhood
information for spatial clustering. ICR and POL data are not
associated with a channel position file and no spatial clustering
will be computed. TFC analysis based on source montages
(SWF) should be associated with a source position file
(*.bsa, see 12.7.4) so that BESA Statistics can display the
sources at their correct position.
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Specific Issues when Analyzing Time Frequency Data

Select data type for which statistics
shall be performed

TFC
] swrF
ERP / ERF
[] EEG
MEG
] IcrR
[] PoL
[] Image
[] swr
[] ERP/ERF

cond 1 - 6% O
Date modified
18102011 1621

Name
SLifc

18102011 1624
18102011 1628
18102011 1631
18102011 16:40
18102011 1642
18102011 1647
18102011 16:50
18102011 1705
18102011 17:09

s2tfc
sattc
stte
Safc
Séifc
s7tte
Satic
Saiic
5104c

File pame 51852 "SI US4 S A SEECT ST v

Files clype: TFG Files (") - Gamcel

cy Dats\TFC \Cond 2+
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2 Specific Issues when Analyzing Time Frequency Data

15.3. Set Parameters

File Edit View Export Help

Set Parameters ’} B ES A

DS @ e =
Workflow Overview -
Run Preliminary t-Test ] J
Set Project Targets of
Statistical Analysis Starttime [ms] D
-200.000
Load Data L4
7 Endtime [ms]
Set P t
et Parameters DID 800.000 D
Perform Statistics Cirg = Start Frequency [Hz]
= mED =
4.000
=) oo 00O DD g L <
O @& me — 9] End Frequency [Hz] 0
= DDD OO EE Do ip o) 46.000
— Ny opOEmE S O @ | B =
i i1 5 U:‘D Statistical Settings
O ] =2
Neighbor Distance
| 0 [em] 4.00
2 Cluster Alpha 0.050
-4} Number of
Armplitude Permutations 10
[%] [T Average over Time
= [7] Average aver Frequency
. gCicston . ] Average over Channels
£ a-|ads U5pm 2 40 aldg 2
= | = 304
£ ig_ 0.0 g -y 0.0 Display Left Display Top/Right
:‘T 10- 05 % 10- 0.2 Condition 1 Difference
e | - o Armplitude | | 9 Amplitude E Condition 2 t-Values
n cy [ms] [%] 0 cy [ms] 1] Mask Mask
Select Channel
Preliminary statistics computed successfully. A145 -
For more information about this Workstep see the Set Parameters section in the description
of the BESA Statistics Workflow. Current Latency [ms] =

Once preliminary statistics are computed, an electrode / sensor of interest can be selected by either
left-clicking on it in the Main Window or by using the Select Channel drop down box in the Interaction
Window. The selected channel is marked by a frame. Please note that you can quickly browse through
the channels using the arrow buttons to the left and right of the Select Channel drop-down box. The
selected channel will be displayed in the left and right Detail Windows.

A crosshair can be placed at a time-frequency point of interest by entering a latency (in ms) /
frequency (in Hz), dragging the Current Latency / Current Frequency slider or using the left and
right arrow buttons next to the sliders in the Interaction Window.

Display Left in the Interaction Window defines what is being displayed in the left Detail Window. By
default, Group / Condition 1 and Group / Condition 2 will be displayed along with a Mask indicating
sifnificant time periods. Time-frequency ranges, during which group / condition 1 has smaller values
than condition 2 are displayed in blue. Time-frequency ranges, during which group / condition 1 has
larger values than condition 2 are displayed in red. If desired, the mask as well as each of the groups /
conditions can be switched off by un-checking the tick-mark in the according selector boxes.

Display Top/Right in the Interaction Window determines what will be displayed in the right Detail
Window and the Main Window. A selection can be made between Difference, i.e. the difference
between groups / conditions or the according T-/F-/R-Values. It is also possible to display the Mask of
significant time-periods in the right Detail Window analogue to the left Detail Window.

In case TFC data based on EEG / MEG channels are analyzed, the Neighbor Distance should be
specified according to the current channel layout. As different EEG caps will have a different number
of electrodes with different mean distances, each electrode cap will require a particular Neighbor
Distance. The same is true for MEG systems. The summary window in the Run Statistics workstep
allows inspecting the correctness of the Neighbor Distance.
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If desired, the Starttime / Start Frequency
and Endtime / End Frequency can be adjusted.

When analyzing TFC data it is possible to Average
over Time, Average over Channels and Average

over Frequency

15.4. Perform Statistics

Please note that running the permutation test on TFC data
can take several minutes depending on the number of
subjects, channels, and time-frequency bins.

Starttime [ms]

200000 (€[}
Endtime [ms]
800.000 (€] L[>
Start Frequency [Hz]
4000 (€[}
End Frequency [Hz]
46000 (€] L[>

Statistical Settings

MNeighbor Distance

[em] 3.0
Cluster Alpha 0.050
MNumber of

1000

[] Awverage over Time

Permutations

[] Awerage over Frequency
[] Awverage over Channels

Perform Statistics

| 4%

Perform Statistics

(= =

Workflow Overview
Set Project Targets

Statistical Analysis
Load Data

Set Parameters

[ Perform Statistics

Amplitude
[%]
Medication Difference
FEIE et Ly N ICGE P 0.2
= 304 0o T 3 0.0-
g 20 5 20
5 10 0.5- g - e
= i =+ Amplitude | = T Arnplitude
0 ...ty [ms] [%] 0 ...y [ms] [%]

Statistical calculation finished successfully.

Note: These results are corrected for multiple comparisons.
For more information about this Workstep see the Perform Statistics section in the
description of the BESA Statistics Waorkflow.

File Edit View Export Help

' 1YBESA

¥ Lonaman 1 ¥ UIMErence

[l Condition 2 O t-Values
[ Mask ] TF Map
Mask

Select Time Frequency Range
Starttime [ms]

-125.000 < >
Endtime [ms]
800.000 < >
Start Frequency [Hz]
4.000 < >
End Frequency [Hz]
46.000 <€ >

Select Channel

Current Latency [ms]

400.000 {
Current Frequency [Hz]
6000 (€)1}
Set Scale
0
Display Settings
Scale x 1.0
(<
i‘ I:l Zoomx 2.5
m <

-

m
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Specific Issues when Analyzing Time Frequency Data

Permutation test results will be clusters where the null- Difference

hypothesis is rejected, i.e. data are not interchangeable. By e 03-
default, BESA Statistics automatically selects the cluster and = 3 ':'.
the corresponding source / orientation with the largest T-/F- g st . . 0.0-
/R- value for visualization in the Detail Windows. 5 207 T

2 104 -y -0.2—
All channels belonging to a cluster are overlaid with the - 0 oy [me] Amp"t'['odfi

according cluster mask, if the mask is displayed.

15.4.1. Time-Frequency Mapping in TFC ERP / ERF Data

If a t-test or a correlation project was chosen and permutation testing was run on sensor space TFC
data (TFC ERP / ERF), it is possible to display a topographic map of the mean difference between
input groups / conditions (t-test) or the mean of the input group / condition (correlation) for TFC
clusters. This feature can be helpful in order to investigate, what the distribution of the original sensor
space data was that led to a significant effect in the time-frequency domain for t-testing or correlation.

By default, the mean values displayed in the TF map are based on the time and frequency range of
the selected cluster. Starttime / Endtime, as well as Start Frequency / End Frequency are
automatically set to these boundaries when a cluster is selected, and can be changed within the
boundaries set by the cluster.

|1 BESA Statistics 2.0 - New Statistics projec

File Edit View Export Help
Perform Statistics . /w B E SA
DEDTE e a
Workflow Overview -
[ Run Statistics ] J T
Set Project Targets of
Statistical Analysis Permutation Test Results
Load Data o Val . Cluster +H- | Vis |~
+ 001 [p=0.04000] - [
Set Parameters 4 002 [p=0.76000] +
Perform Statistics 003 [p=0.82000] +
004 [p=0.82000] +
005 [p=0.86000] +
006 [p=0.86000] +
007 [p=0.84000] - 3
008 [p=0.86000] +
009 [p=0.86000] +
0.2 040 [n=N RRNNNT - 2
0.1+
0.0 Display Left Display Top/Right
0.1 Group 1 [T Difference
a2 [T Group 2 [ tValues
Mask TF Map
Amplitude ) Mask
[%]
Select Time Freguency Range
Starttime [ms] B
Patients Difference
= 0 T O - -50.000 [
N L e Endtime [ms]
= =
S 0t |15 g 0.0- 500.000 >
% o0 ; —— ugj_ a0 - 02 Start Frequency [Hz]
[ = = amplitude | = 4 Amplitude 4.000 D
0 ..oy [ms % 1] ..oy [ms %, End Frequency [Hz
[%] %]
48.000 [
Statistical calculation finished successfully. ol
A Select Channel
Mote: These results are corrected for multiple comparisons. A48 -
For more information about this Workstep see the Perform Statistics section in the =
description of the BESA Statistics Workflow. il
|
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16. Specific Issues when Analyzing Image Data

16.1. Load Data

. - .
When analyzing Image data, BESA Statistics expects *.dat B e,
. . . . . Look jn ~ @033~
files (12.7.4). Each file can contain voxel information on 1 o — s =
H H H H HH H = = [ S1av-highdat 28102011 1637 DAT File —essal
time-point or a time-series. No additional files are required. RecePaces v noneatdaiozmiieyoATre
Desktop 55_av-highdat 28102011 165:38 DAT File 95531
; 56_av-highdat 2810.2011 16:38 DAT File 95531
-w S7_av-highdat 28102011 16:39 DAT File 95531
Libraries 58_aw-highdat 2810.2011 16:39 DAT File 95531
% 59_aw-highdat 28102011 16:39 DAT File 95531
k 510_aw-high.dat 2810.2011 16:39 DAT File 95531
Computer
Notork File ame: “51_av-high daf" "S2_av-high dar' "S3_sv-tigh dat ~ open |
Fies olype: [image Files - dat - Gancel |
(o3 Zoiwielkowi |

16.2. Set Parameters

7 B st 20
File Edit View Export Help
Set Parameters

=

Workflow Overview Eesllus
Set Project Targets
Statistical Analysis

Define Experimental Design

Load Data

[ Set Parameters
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Preliminary statistics computed successfully.
For more information about this Workstep see the Set Parameters section in the description
of the BESA Statistics Workflow.
i
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[ Run Preliminary F-Test J J
Starttime [ms]
269840 (€[
Endtime [ms]
239.080 1]

Statistical Settings

Cluster Alpha 0.001
Number of

Permutations 50
[C] Average over Time

Display Left Display Image
[Cond\t\ons '] IF—VaIues 'I

Select Extremum (F-Values)

Current Latency [ms]

278720 [€)

Set Scale

0

0

0

X Coordinate (TAL) 385
—= =

] »

m

Depending on the parametric test chosen, the main window displays activity in the input groups /
conditions, the activation difference between groups / conditions (t-test only), and statistical values (t-

values, F-values, r-values), based on the selection under Display Image.

If an ANOVA / ANCOVA is calculated, the main window displays the preliminary F-values in the first
row, the second and third row display groups / conditions as selected by the user in the Display
Image drop-down menu. Please note that a maximum of two groups / conditions can be selected at a
time. If the group / condition selection is altered by the user, the previous selection must first be un-

done by un-ticking the according group / condition.

Once preliminary statistics are computed, it is possible to select a voxel of interest by using the Select

Extremum drop down box in the Interaction Window. The selected voxel is marked by a crosshair.
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Specific Issues when Analyzing Image Data

Please note that you can quickly browse through the extrema using the arrow buttons left and right of
the Select Extremum drop-down box. The activation time-course of the selected extremum are
displayed in the left and right Detail Windows. Additionally, Talairach coordinates of the selected
extremum are displayed at the bottom of the Interaction Window.

Please note that it is not possible to specify a Neighbor Distance for image data. The reason is that
the neighborhood structure is given for a volume image consisting of adjacent voxels. l.e. the
neighborhood information is automatically retrieved by BESA Statistics!

16.3. Perform Statistics

Please note that running the permutation test on Image data Perorm Statistics
can take several minutes depending on the number of subjects
and time-points.

|1 Besa setistcs 20
File Edit View Export Help
Perform Statistics ’d B E SA
DEE » @
Workflow Qverview -
Sag Cluster Run Statistics ] J -
Set Project Targets \f
Statistical Analysis Permutation Test Results ANOVA
Define Experimental Design 4 Vval Cluster +- | Vis
sk 001 [p=0.00000] +
Load Data v " * 002 [p=0.02000] +
Set Parameters v 003 [p=0.12000] +
[FYEIES 004 [p=0.14000] +
Perform Statistics L
Post-Hoc Statistics
Del X E
Display Left Display Image
Conditions 'I lF—VaIues V]
[ 0
10 Select Extremum (F-Values)
£ £ I )
nAm/em®
In Mis F-Values Current Latency [ms]
= 2 278.720 I
=
i & T ap
< 10 L QU,/__——l_\__ Set Scale
: 0 i U
S
= Reset
: Latency [ms] Latency [ms] D
| Statiationt caeulation frched ” N X Coordinate (TAL) 385
atistical calculation finished successfully. a3 Y Coordinate (TAL) 169
Mote: These results are corrected for multiple comparisons. Z Coordinate (TAL) 4.3
For more information about this Workstep see the Perform Statistics section in the =
| description of the BESA Statistics Workflow. it Mo

Permutation test results will be clusters where the null-hypothesis is rejected, i.e. data are not
interchangeable. By default, BESA Statistics automatically selects the cluster and the corresponding
source / orientation with the largest T-/F-/R- value for visualization in the Detail Windows.

If an ANOVA / ANCOVA is calculated, the main window displays the clusters in the first row, the F-
values in the second and third row display groups / conditions as selected by the user in the Display
Image drop-down menu. Please note that only one group / condition can be selected at a time. If the
group / condition selection is altered by the user, the previous selection must first be un-done by un-
ticking the according group / condition.
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17. Exporting Images and Results

17.1. Exporting Images

After running preliminary statistics or after the Perform Statistics workstep is finalized it is possible to
export resulting images in the main window and the detail windows. This can be achieved via the
menu bar (see 11.1.4) or via right-clicking in the corresponding window.

|7 BESA Statistics 2.0 - Statist

File Edit View Help
| Image [ 3 in Wi
Perform St % Main Window
Statistical Results 4 Left Detail Window
(= = Right Detail Window
All Windows ‘
Workflow Overview
Set Project Targets (v 4
Statistical Analysis \
. Load Data v )
Images can be saved as portable network graphics (*.png) or M
- Saveinr | SWF - O * @
vector graphics (*.eps). e o
Rewtbacs  Bunoasion e ispetets 5
. . . . % Maineps 18.06.201217:10 Encapsulated P.. 35
The selection can be made in the saving dialogue under Save - Bnonommisn sl e ;
as type: 5
A

Computer

Network

When saving *.png files, the dimension and resolution of the
resulting image can be defined. By default, the current size of
the image on the screen is used. Width and height can be
altered with or without constraining proportions using mm or Set image dimensions
inch as units. The resolution can be set to 150, 300 or 600 dots
per inch. Width Height

642 276 pixel
When saving *.eps files the image size cannot be changed as
vector graphics are by definition fully resizable. 108.712 _ | 46.8324 @

Constrain proportion:

[] Use current size

Set Resolution (dpi}

| ok || cance |
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Exporting Images and Results

17.3. Exporting Statistical Results

After the Perform Statistics workstep is finalized
it is possible to export statistical results via the
menu bar (see 11.1.4). A choice can be made
between “Summary of Cluster Statistics” and
“Detailed Results per Cluster”. The resulting files
are comma-separated.

Summary of Cluster Statistics will output
the cluster value, p-value, cluster boundaries and
means for condition/group 1 and 2 for each
cluster found. For ERP/ ERF and TFC data,
labels of the channels that are associated with a
cluster are also exported.

Detailed Results per Cluster will output
mean values per person and group/condition for
each cluster.

File Edit View | Export| Help

Perform St

Image

BESA Statistics 2.0 - Statistical Projects 1 -

'

Statistical Results »

=

Workflow Overview

(Statistics project

Summary of Cluster Statistics

Detailed Results per Cluster

H

0

0
0
0
0
0

File Name Group/Condition Cluster 1 Cluster2 Cluster3 Cluster4 Cluster5 Cluster6

S1_av-exp High
52_av-exp High
S3_av-exp High
S4_av-exp High
S5_av-exp High
S6_av-exp High
S7_

S8_av-exp High
S9_av-exp High
510_av-ex High
S1_av-exp Low
52_av-exp Low
S3_av-exp Low
S4_av-exp Low
S5_av-exp Low
56_av-exp Low
S7_av-exp Low

av-exp High

58_av-exp Low
S9_av-exp Low
$10_av-ex Low

171.953
169.847
145.465
208.697
0.97476
191.059
110.585
116.152
0.445815
168.562
0.643345
0.59677
0.0202673
0.721863
0.161173
0.469015
-0.155377
0.408926
0.0253412
0.240665

-151.161 -194.226
-181.393 -136.974
-160.939 -0.763417
-200.994 -282.052
-116.565 -0.769849
-198.049 -141.889
-132.591 -105.209
-108.109 -0.81392
-0.88784 0.176864
-101.396 -306.497

-0.626427 -0.36212
-0.681179 -0.1748
-0.110512 0.431863
-0.556209 -0.448149

-0.47262 0.152608

-0.5338540.0798142
-0.149824 0.434543
-0.377373 0.168674

-0.16751 0.595101
0.159776 -0.376014

-263.472
-505.065
-308.214
-168.923

-0.856455

-389.266
-131.805

-233.962
-293.862
-128.735
-271.552
-106.496

-0.711987
-0.349198

-191.912

-0.605937
-0.268427
-0.932934

-111.691

0.801743 -
341.797
271.868
220.373

0.872301
424777

-0.285907

-0.7382870.0227702

240.692

460.878
-0.628347 -
0.938874 -
-0.256526 -
-0.436034
0.217433
0.5422020
-0.473177
-115.001 -
-0.485215
-0.349912 -

0.507554
-157.004

-0.869147
-0.962667

-18.556

-0.356282
-0.332387

-0.72513

-0.845003

-135.099
0.282522
0.371693
0.231328
0.275218
0.421711
.0566957
0.934194
0.418365
0.112018
0.757587

Set Project Targets o
Statistical Analysis
| Load Data 4 )
A B c D E F G

1 Cluster ID p-value Clustervalue Mean for High Mean for Low Start Time End Time Start Frequency Frequency
2 Cluster 1 0 1968.64 142.438 0.308131 144 484
3 Cluster2  0.001  -1505.43 -143.998  -0.351573 252 548
4 Cluster3  0.003  -537.501 -138.388  0.0501521 152 240
5 Clusterd  0.009  -394.209 -245.404. -109.723 72 132
6 Cluster5  0.056 214.41 209.692  -0.208071 68 128
7 (Cluster6  0.057 -212.52 093748 -0.110508 572 644

cocoooo

Important Note on mean values derived from ANOVAs /| ANCOVAs

When ANOVA / ANCOVA is used as preliminary test, clusters are derived based on F-values. F-
values can only be positive, irrespective of the underlying data having positive or negative values. For
example, an F-test cluster can be identified in MEG sensors picking up activity of dipolar fields, i.e.
some sensors will be associated with positive and some with negative values. Exporting mean values
for the cluster can then result in values around 0. Therefore, mean values based on F-test clusters

should be interpreted with caution.
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18. Appendix
18.1. How to deal with bad channels when analyzing ERP / ERF data

By default, BESA Statistics only utilizes information about EEG / MEG channels configurations as
available in the elp-file (see 12.7.4 and 19). The elp-file does not contain information on channel
status, e.g. channels that were excluded from analysis in BESA Research by setting them as bad.
Thus, all channels that were previously defined as bad will still be used by BESA Statistics. This might
not be desirable, as the channels might contain flawed data.

On the other hand, it can be a problem for cross-subject statistics if bad channels are defined and
shall be excluded. If different bad channels are defined for different subjects, the number of channels
does not match across subjects. This is a requirement for cross-subject statistics as it is implemented
in BESA Statistics, however. There are two ways to deal with this problem:

18.1.1.Interpolating bad channels in BESA Research

The easiest solution might be to interpolate all bad channels in BESA Research by right-clicking on the
channel label and choosing “Interpolate this channel” rather than “Define channel as bad”.
Alternatively, you can press “Edit / Bad Channels” and double-click on all channel labels in the right
panel. This will also lead to bad channels being interpolated. After interpolation you should export
(“File / Export”) the data with the setting “Current Montage”. This will lead to BESA Research
outputting the interpolated EEG / MEG channel traces rather than the flawed data of the bad channels.

18.1.2. Creating a channel montage only containing good channels in BESA Research

If you want to omit bad channels from statistical analysis, you should create a new channel montage in
BESA Research. With a concerned dataset open, press “Edit / Montage” to open the montage editor.
In the middle pane you can now delete all channels you want to omit from statistical analysis by right-
clicking and selecting “Delete montage channel ...”. Save the newly created montage by pressing “File
/ Save Montage as”. Please specify a name of your choice. This user-montage can now be applied to
the datasets of all subjects that should enter statistical analysis by pressing the USR button and
selecting the according montage for each dataset.

The data can now be exported for statistical analysis (“File / Export”) with the settings “ASCII
vectorized” and “Current Montage”. This will make sure that all subjects are associated with the same
number of channels.

What you will need to do additionally is to export a new elp-file containing only information about the
channels in the montage. To do so, make sure that the montage you want to use is applied on the
data. Next, press “File / Head Surface Points and Sensors / Save Electrode File for Current
Montage”. This will make sure that the number of channels and the labels of the used channels are
identical in the exported data and the elp-file.

18.2. How to deal with re-montaged or re-referenced data

In case you have already created a channel montage only containing channels of interest or if you are
dealing with re-referenced data, you should follow the same procedure as outlined in chapter 18.1.2.,
second and third paragraph.
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19. File Formats

In case BESA Statistics is used for data created in other software, files need to be prepared to meet
file format expectations.

In the following we describe the requirements which data created using other software should meet to

be compatible with the BESA Statistics data formats described in the table of section 12.7.4. All BESA
Statistics data formats are in ASCII format to facilitate human readability. All floating point numbers are
represented in scientific notation with up to eight significant digits. An exception to this rule are the

BrainVision Analyzer 2 data formats that are supported (*.vhdr files; for a format description please
consult the manual of the BrainVision Analyzer 2 software).

19.1. The BESA Statistics Time-Frequency File Format (*.tfc)

The header line contains the following data descriptors (13 descriptors displayed in bold, the values
shown are only examples and comments are in italic):

1. VersionNumber=__v_5.1: Version number of the current software.
2. DataType=COHERENCE_SQUARED: Data type contained of the file. Possibilities are:
¢ COHERENCE_SQUARED: coherence values squared.

o ERDERS_AMP: ERD(event-related desynchronization) and ERS(event-related
synchronization) amplitudes.

o ERDERS_POWER: power.
o ERDERS_AMP_P_VALUE (not allowed for BESA Statistics)

e ITPL: Inter-trial phase locking is a measure for the phase consistency of the oscillatory
response of a single surface or source channel across multiple trials.

e PHASE_COHERENCE: phase coherence.

e ERDERS_AMP_P_VALUE (not allowed for BESA Statistics)
¢ TIME_FREQUENCY_AMP: time frequency amplitude.

e TIME_FREQUENCY_POWER: power.

3. ConditionName=s:Condition name. Usually indicated by experiment. E.g. "high-" or " low
intensity".

4. NumberTrials=250: Number of trials.

5. NumberTimeSamples=25: Number of time samples.
6. TimeStartinMS=-100.0: Start time in [ms].

7. IntervallnMS=25.0: Interval length in [ms].

8. NumberFrequencies=24: Number of frequency bins.
9. FreqStartinHz=4.0: Starting frequency in [Hz].

10. FreqintervallnHz=2.0: Frequency interval in [HZ].
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11. NumberChannels=127: Number of channels in the data set.
12. StatisticsCorrection=0ff: Statistics correction flag.

13. EvokedSignalSubtraction=0ff: Flag to signal evoked signal subtraction (On if evoked signal
is subtracted, Off otherwise).

The second row of the header contains the labels of the channels. Their labeling can be chosen freely
provided only letters and number are used and the amount of characters per entry does not exceed
eight (e.g. E1 E2 ... for electrodes).

The remaining lines contain NumberChannels blocks starting from the first channel. Each block is
separated from the next one by an empty line. Each block contains NumberFrequencies-rows
and NumberTimeSamples-columns. The values for each time-frequency entry in the blocks are
floating point numbers and should be separated by a tab.
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19.2. The BESA Statistics Channel Definition File Format (*.elp)

Each line of the channel definition file contains one label, an identifier and 2D coordinates. The format
is: Identifier Label Theta-coordinate Phi-coordinate.

Identifiers can be:
e EEG -- scalp electrode (use also instead of SCP).
e POL -- polygraphic channel (use also instead of PGR).
¢ ICR --intracranial electrode.
e MEG -- MEG sensor.
¢ REF -- reference electrode. This can only occur once.

Labels should have at most 8 characters and be constituted only by letters and numbers, but
can otherwise be chosen freely. Note though that the corresponding *.avr files (see 19.6) have to use
the same convention for the label naming.

Coordinates are represented as floating point numbers in [deg] in the unit sphere coordinate system.
This coordinate system is defined by reference points on the head known as fiducials. The reference
points are normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point
(RPA). The x axis is defined by the line joining LPA and RPA, positive towards RPA. The y axis is
defined by the line through NAS that is perpendicular to the x axis (positive towards NAS). The z axis
is perpendicular to the x and y axes, and goes up out of the upper part of the head (e.g. Cz). The
Theta-coordinate (azimuth) is zero at the z axis, 90 deg at the x axis and -90 deg at the negative x
axis. The Phi-coordinate instead goes from [-90 deg, 90 deg] from the negative y axis to the positive y
axis for positive theta (i.e. for the right hand side of the scalp), while it goes from [90 deg, -90 deg]
from the negative y axis to the positive y axis for negative theta (i.e. for the left hand side of the scalp).
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File Formats

19.3. The BESA Statistics Solution File Format (*.bsa)

The file contains the position and orientation of dipoles/sources.

The first line of the file contains a dummy identifier BSA_1.04.19990715.

The second line of the file contains the labels: Type, x-loc, y-loc, z-loc (the position of the
dipole/source in unit sphere Cartesian coordinates), x-ori, y-ori, z-ori (the unit vector orientation of the

dipole/source).

This coordinate system is defined by reference points on the head known as fiducials. The reference
points are normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point
(RPA). The x axis is defined by the line joining LPA and RPA, positive towards RPA. The y axis is
defined by the line through NAS that is perpendicular to the x axis (positive towards NAS). The z axis
is perpendicular to the x and y axes, and goes up out of the upper part of the head (e.g. Cz).

Type can assume the values:
1. SngDip - single dipole.

2. RegSrc - regional source.
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19.4. The BESA Statistics Image File Format (*.dat)

Source analysis files are used to store a number of possible scenarios:

¢ Image ASCII Files: Image amplitudes of all grid points in the currently displayed image in the
current image resolution.

¢ Image ASCII Files - all latencies: Image amplitudes of all grid points in the current image
resolution for all time points.

The header looks like the following example (required labels are in bold, comments are in italic and all
other text serves as sample input):

BESA_SA_IMAGE:2.0

Data file: C:\ExampleDirectory\exampleFile.foc: Meta information.
Condition: s Low Filter: 0.5 Hz: Condition name, usually specified by the
experiment.

Method: Standard LORETA: Used method. See below.

Regularization: First: SVD 0.0050lterations: SVD 0.0050;: Meta information.
nAm/cm*3

Grid dimensions ([min] [max] [nr of locations]):

X: -73.500000 73.500000 22: Min, max and number of points along the X axis.

Y:-107.930000 74.070000 27: Min, max and number of points along the Y axis.

Z: -60.340000 79.660004 21: Min, max and number of points along the Z axis.

Method can assume the following values:

¢ MSBF

e CLARA

e Standard LAURA

e Standard LORETA

e Standard sSLORETA

e Standard swLORETA

e Standard SSLOFO: 3 iterations, clip 10, smooth 1.0;
The data section following the header is composed of matrixes of nr of locations - of X columns and
Y rows with values for each voxel at this slice (where the slice is indexed by Z). There are nr of

locations (specified in the header for Z) slices and the index starts at zero. Slices are separated from
each other by an empty line.
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The data section for Image ASCII Files will look like e.g.:

Z:12

0.0000000000 0.0000000000 0.0000000000 0.0000000000

0.0000000000 0.0000000000 0.0000000000 0.0000000000

0.0000000000 0.0000000000 0.0000000000 0.0000000000

0.0000000000 0.0000000000 0.0000000000 0.0000000000

0.0000000000 0.0000000000 0.0000000000 0.0000000000

0.0000000000 0.0000000000 0.0000000000 0.0000000000

0.0000000000 0.0000000000 0.0000000000 1.1316120625

0.0000000000 0.0000000000 0.0000000000 1.6725080013

0.0000000000 0.0000000000 1.0726528168 2.2005338669

0.0000000000 0.0000000000 1.5812959671 2.8961703777

0.0000000000 0.0000000000 2.1061606407 3.6263871193

0.0000000000 0.0000000000 2.6111714840 4.3519711494

0.0000000000 0.0000000000 2.8889267445 4.7082519531

0.0000000000 0.0000000000 2.8630757332 4.6019945145

0.0000000000 0.0000000000 2.5799186230 4.1517233849

0.0000000000 0.0000000000 2.1543741226 3.4361450672

... nr of locations of Y entries.

... nr of locations of X entries.

For each time sample the corresponding data block starts with the label Sample and the number of
the current sample e.g. 1, and after a comma separator follows the latency in milliseconds followed by
the unit label "ms". Furthermore the amount of equal signs (‘=’) to limit each latency sample is 94.

The data section for Image ASCII Files - all latencies - all latencies will ook like e.g.:

66



11 BESA

Sample 1, 0.00 ms
Z:0

0.0000000000 0.0000000000 0.0000000000 0.0000000000 ... nr of locations of X entries.

... nr of locations of Y entries.

Sample 2, 4.00 ms

Z:0
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19.5. The BESA Statistics Source Waveforms File Format (*.swf)

The header line contains the following data descriptors (8 descriptors displayed in bold, separated by
blank spaces, the values shown are only examples. Comments are in italic.):

1. Npts=200: number of sampled points in each channel.

2. TSB=-500: time sweep begin [ms]. Time of first data point relative to zero of epoch.
3. DI= 5: digitization or sampling interval [ms].

4. SB= 1: default scaling bins/nAm in file.

5. SC= 200: default scaling calibration.

6. CondFile= "OrigFile.fsg": Name of the original bin file.

7. CondName= "S1: 100 avs": Condition name, usually specified by the experiment.

8. Filter= "Filters off": status of the filters.

Each remaining line begins with the name of the source followed by floating point values for all Npts
time points.

In the case of regional sources which were oriented before the export, we obtain three rows for each
source (one for each orientation).

19.6. The BESA Statistics ERP / ERF ASCII Vectorized File Format (*.avr)

The first of two header lines contains the following data descriptors (7 descriptors, the values shown
are only examples):

1. Npts= 200: number of sampled points in each channel.

2. TSB=-500: time sweep begin [ms]. Time of first data point relative to zero of epoch.
3. DI= 5: digitization or sampling interval [ms].

4. SB= 1: default scaling bins/nAm in file.

5. SC= 200: default scaling calibration.

6. Nchan= 27: number of channels.

7. SegmentName= 60dB : an optional label describing the data.

The second line of the header contains the labels for each channel separated by a blank space. They
can be chosen freely, however they have to correspond to whatever convention was used in the
corresponding (see 19.2).

Each of the subsequent Nchan lines of the file contains floating point values for all Npts time points.
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